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IMPORTANT NOTICE 

All information in this document, such as descriptions, specifications, drawings, recommendations and other 
statements, is believed to be correct and reliable. Although given in good faith, the accuracy and/or completeness 
of such data is not guaranteed or legally binding on Parker Meggitt (Meggitt SA) and we reserve the right to alter 
any part of this document/publication without prior notice. Before acquiring and/or using this product, you should 

evaluate it and determine if it is suitable for your intended application. You should also check our website at 
www.meggittsensing.com/energy to ensure that the latest versions of documentation are being used. For example, 
data sheets, certificates, product drawings, user manuals, service bulletins and/or other instructions affecting the 

product. 

Unless expressly agreed in writing with Parker Meggitt, you assume all risks and liability associated with use of the 
product. Any recommendations and advice given without charge, whilst given in good faith, are not legally binding. 

We take no responsibility for any statements related to the product which are not contained in a current 
Parker Meggitt publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by us. 

The certifications and warranties applicable to the products supplied by Parker Meggitt are valid only for new 
products purchased directly from us or an authorized distributor. 

Parker Meggitt reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
use of any information contained in this document complies with all relevant export control regulations. ECN N /A. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Parker Meggitt (Meggitt SA). 
It is applicable to all VibroSight-based condition monitoring systems using the versions of software described by 
this document, namely: 

• VibroSight software version 7.8.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 7.7.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Parker Meggitt documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-228A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-238A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay modules data sheet 
        (document reference 268-125) 

 VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules data sheet 
        (document reference 268-140) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-213A) 

 VibroSight application notes and technical notes. 
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Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.7.0 (document reference 660-010-013-240A) 

• VibroSight 7.6.0 (document reference 660-010-013-239A) 

• VibroSight 7.5.0 (document reference 660-010-013-238A) 

• VibroSight 7.4.0 (document reference 660-010-013-237A) 

• VibroSight 7.3.0 (document reference 660-010-013-236A) 

• VibroSight 7.2.0 (document reference 660-010-013-235A) 

• VibroSight 7.1.0 (document reference 660-010-013-234A) 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 
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• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Parker Meggitt (Meggitt SA) products that can be used with the VibroSight® 
software, the following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules and the RLC16Mk2 relay module – 
standard and SIL versions, and the AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules, and 
the CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.8.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Parker Meggitt 
(Meggitt SA) customer support. See 8 Customer support. 

 

 

2 Features 

General 

2.1 Support for the VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module 

VibroSight 7.8.0 broadly enhances support for VM600Mk2 rack-based machinery protection and condition monitoring 
systems with the introduction of a new VM600Mk2 module, namely: 

• VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module. 

 

VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules 

The new VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules are designed for operation 
with the second generation of VM600Mk2 rack-based machinery monitoring system, from Parker Meggitt’s vibro-
meter ® product line. 

A VM600Mk2 AMC10Mk2 + IOC10Mk2 module consists of a processing module and an input /output module that 
together provide ten measurement channels of machinery protection and condition monitoring in VM600Mk2 
systems. 

The 10 measurement channels are configurable as temperature or analog inputs, and are compatible with 
thermocouples, resistance temperature detectors, and other/custom sensors (DC current). For thermocouples, 
internal or external cold-junction compensation (CJC) is supported. All measurement channels have individually 
configurable inputs, processing and outputs (with simultaneous data acquisition). 

There is 1 processed output per channel, and multiple alarms per processed output with configurable limits, 
hysteresis and time delay. Logic functions (AND, OR and majority voting) are available for the combination of alarm 
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and status information, with 2 relays for use by alarms. There are also 10 analog outputs (4 to 20 mA signals) used 
to provide quasi-static outputs corresponding to measurements. 

And like other VM600Mk2 modules, the AMC10Mk2 + IOC10Mk2 module features diagnostics (built-in self-test (BIST)), 
epoxy-sealed (or equivalent) relays, direct system Ethernet communications (100 Mbps), compatibility with 
VM600Mk2 system racks (ABE04x) and slimline racks (ABE056), software configuration, live insertion and removal 
of modules (hot-swapping) with automatic reconfiguration, etc. 

NOTE: For more detailed information, refer to the VM600Mk2 AMC10Mk2 + IOC10Mk2 
temperature and analog monitoring modules data sheet. 

 

In VM600Mk2 systems, the AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module adds machinery 
protection and condition monitoring support for applications with large numbers of slowly-varying (quasi-static) 
analog signals, such as temperature and other process variables. 

For VM600Mk2 AMC10Mk2 + IOC10Mk2 modules, both machinery protection and condition monitoring functionality are 
available by default. (For reference, for VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition 
monitoring modules, machinery protection functionality is available by default and condition monitoring functionality 
is optional.) However, it is important to note that condition monitoring functionality also depends on the purchased 
VibroSight ® software license. 

 

The VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules can be considered as second-
generation replacements for the first generation VM600 AMC8 and IOC8T analog monitoring card pairs, which they 
effectively replace. (In the same way that the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition 
monitoring modules replaced the VM600 MPC4 + IOC4T modules.) 

NOTE: The new VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring 
modules use the latest technology to offer improved performance compared to the 
old VM600 AMC8 and IOC8T analog monitoring card pairs. 

 

 

VibroSight ® machinery monitoring system software 

The VM600Mk2 AMC10Mk2 + IOC10Mk2 modules are designed and optimized for operation with the VibroSight ® 

machinery monitoring system software (in the same way as the VM600Mk2 MPC4Mk2 + IOC4Mk2 modules). 
Accordingly, VibroSight 7.8.0 includes significant updates in order to support the new VM600Mk2 AMC10Mk2 + 
IOC10Mk2 modules. 

(For reference, the old VM600 AMC8 and IOC8T analog monitoring card pairs were configurated and operated 
using the old VM600 MPSx software.) 

As a result, users of VibroSight / VM600Mk2 systems who are familiar with the VM600Mk2 MPC4Mk2 + IOC4Mk2 will 
find it quick and easy to add and start using VM600Mk2 AMC10Mk2 + IOC10Mk2 modules in their applications. 
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In general, for VM600Mk2 AMC10Mk2 + IOC10Mk2 modules, as per other VM600Mk2 modules: 

• VibroSight Protect is used for the configuration and operation of modules for machinery protection 

• VibroSight Capture is used for the configuration and operation of modules for condition monitoring 

• VibroSight System Manager is used for the general management of modules 

• VibroSight Vision is used for the display and analysis of measurement data. 

 

 

VibroSight Protect and the VM600Mk2 AMC10Mk2 + IOC10Mk2 module 

VibroSight Protect is the VibroSight software module, featuring a modern and ultra-clear user-interface, designed 
for the configuration and operation of VM600Mk2 systems for machinery protection. 

VibroSight Protect allows for the configuration of complete VM600Mk2 systems, consisting of: 

• VM600Mk2 racks – 6U (ABE04x system racks) and 1U (ABE056 slimline racks) 

• VM600Mk2 MPC4Mk2 + IOC4Mk2 modules 

• VM600Mk2 RLC16Mk2 modules 

• VM600Mk2 AMC10Mk2 + IOC10Mk2 modules 

• VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface modules. 

 

NOTE: VibroSight Protect is completely separate and distinct to VibroSight Capture and 
VibroSight Configurator in order to ensure the complete separation (“segregation”) 
of machinery protection and condition monitoring in a VM600 rack. 

 

 

VibroSight Protect user interface – Welcome screen 

When VibroSight Protect starts, the Welcome screen displays a view that allows the user to create a new 
VM600Mk2 system configuration (New system), open an existing VM600Mk2 system configuration file (Open Protect 
file), duplicate an existing VM600Mk2 system configuration file (Duplicate Protect file), or connect to VM600Mk2 
system hardware (Connect to system). 

This is shown in Figure 1. 
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Figure 1: VibroSight Capture Welcome screen 

 

Alternatively, File menu commands can be used to perform the same functions (New, Open, Duplicate, Connect). 

For example, to start working on a new VM600Mk2 system configuration using a VM600 system rack (ABE04x), click 
the VM600 - 6U icon. 

 

When working on a VM600Mk2 system (new or existing), the VibroSight Protect user interface consists of three main 
tabs/pages: Layout, Configure and Dashboard. 

 

 

VibroSight Protect user interface – Layout tab/page 

The Layout tab/page is used for the configuration and display of general information for the VM600 rack / VM600Mk2 
system. 

For example, a VM600Mk2 system consisting of a single VM600Mk2 AMC10Mk2 + IOC10Mk2 module is shown in 
Figure 2. 
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Figure 2: VibroSight Protect Layout tab/page 

 

System properties (left) is used to define information about the rack, including the specific type of rack. 

System I/O (left) provides summary information on the inputs, outputs and resources used by the rack. This is 
dynamically updated as modules are added to the rack and configured. 

Power consumption calculator (left) is used to define information about the power supply configuration used by the 
rack. This is dynamically updated as modules are added to the rack and configured, so that the user knows if the 
power supply configuration is suitable for the populated rack. 

Main window (centre) is used to add modules to the rack. Double-clicking a blank (empty) rack position/slot allows 
a new module to be selected for that position/slot. 

For example: 

AMC10Mk2 modules can be added in position/slots 3 to 14 (front of rack). When a AMC10Mk2 module is added, the 
associated AMC10Mk2 module is automatically added in the corresponding position/slot in the rear of the rack, 
as per MPC4Mk2 modules. 

RLC16Mk2 modules can be added in position/slots 1 to 14 (rear of rack). 

In the main window, the Rotate control (top right) is used to toggle the view of the rack between the front view or 
the rear view. 

In the main window, the Bus view control (top right) is used to toggle the view between the rack view or the rack 
buses view. 

The Bus view is shown in Figure 3. 
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Figure 3: VibroSight Protect Layout tab/page – Bus view 

 

In the Bus view, the rack buses are shown as grey if unused or shown as blue if used. If a bus is used, then 
jumpers on the IOC10Mk2 (and any RLC16Mk2 if used) must be manually configured. Jumper configuration is 
available from the Configure tab/page by selecting each module and then its Jumpers tab, as per MPC4Mk2 
modules. 

To display more detailed information on the configuration and usage of individual VM600 rack buses, click one of 
the bus names (left of rack) on the Bus view in order to display an individual bus window: 

• Raw bus 
64 lines 

• Tacho bus 
6 lines 

• OC Bus F 
16 lines 
to 
OC Bus A 
16 lines 

The individual bus windows for the Tacho bus, Raw bus and OC Bus n display detailed information on the 
configuration and usage of the individual VM600 rack bus. Initially, they show the default bus configuration as 
determined by VibroSight Protect for the application. They also allow the automatically assigned bus configuration 
to be changed, should this become necessary. 
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System (right) is used to remove modules from the rack. 

History (right) is used to undo or redo recent changes to the rack using the “–” icon (Remove item). 

 

 

Consistency checks 

Consistency checks (bottom) is used to run and/or display consistency check information so that any problems in 
the VM600Mk2 system configuration can be corrected. 
Clicking on the Consistency check title bar expands or collapses the consistency check window, as required. 
Clicking on the “play” triangle (top left) in the expanded consistency check window will run the consistency check. 
The Consistency check title bar is displayed in purple if no problems are detected but is displayed in red if 
problems are detected. 

 

 

VibroSight Protect user interface – Configure tab/page 

The Configure tab/page is used for the configuration and display of general information for the modules in the 
VM600 rack / VM600Mk2 system, that is, the VM600Mk2 AMC10Mk2 + IOC10Mk2 (and any RLC16Mk2 if used), as per 
MPC4Mk2 modules. 

This is shown in Figure 4. 

 

 

Figure 4: VibroSight Protect Configure tab/page – General information (module level) 
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Main window (top) shows the bottom portion of the rack configured in the Layout tab/page.  

As in the Layout tab/page, the Rotate control (top right) is used to toggle the view of the rack between the front 
view or the rear view. 

 

When a VM600Mk2 module is selected in the rack (top) by clicking on it, the main features for the module are 
displayed in functional groups in the main window (left) and general information for the module is displayed in the 
main window (centre). 

For a VM600Mk2 AMC10Mk2 + IOC10Mk2 module, the main features are Channels, Logical functions, Relays and 
Analog outputs (note: you may need to scroll down (left) to see everything). 

The General tab includes Enabled control, Tag name, Description and Serial number settings for the module. 
There are also the Network settings (Mode and IP address) for the module. And a Blink front panel LEDs control 
that can be used to help identify the module in a rack. 

NOTE: For users who are more familiar with the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery 
protection and condition monitoring module, please be aware that the 
VM600Mk2 AMC10Mk2 + IOC10Mk2 does not support two features that are not 
supported by the module VM600Mk2 MPC4Mk2 + IOC4Mk2 module, namely: 

• A “Watch RLC16 relay status” option that allows the MPC4Mk2 to monitor the 
status of an associated VM600Mk2 RLC16Mk2. 

• A status (common circuit-fault relay (FAULT)) relay.  

 

The Jumpers tab provides any jumper configuration, if required. 

 

When an item is selected from a functional group in the main window (left), the main window (centre) updates to 
display the information for the item, including all configurable parameters. 

For example, when configuring a measurement channel, the information displayed in the main window includes 
General, Processing, Alarms and Full display range tabs, which allows each of these elements to be reviewed 
and/or edited (after initial configuration). 

This is shown in Figure 5. 
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Figure 5: VibroSight Protect Configure tab/page – Configuring a measurement channel 
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For all VM600Mk2 modules 

To configure the network communication settings for a VM600Mk2 module, on the Configure tab/page, select the 
module (top), then in the main window (centre), on the General tab, under Network settings, use the Mode and 
other controls to determine how VibroSight Protect should find the IP address to be used for communication with 
the module: 

• With Mode: Automatic discovery from serial number, the module is automatically identified using the serial 
number that is entered manually in the Serial number text box. 

NOTE: The serial number of a VM600Mk2 module can be found by inspecting the labels 
(stickers) on the module hardware (for example, front panel) or by using VibroSight 
System Manager. 

 

The card’s IP address will then automatically be read by VibroSight Protect for use by the system and 
displayed in the IP address text box. 

NOTE: VibroSight uses a proprietary implementation of the zero-configuration networking 
(zeroconf) protocols in order to support networking operations such as the 
automatic discovery of VM600Mk2 modules. 
If the automatic discovery does not work (for example, due to a network not 
meeting the requirements of zeroconf), then connections between VibroSight-
system components can be established manually by entering the IP addresses of 
the network devices. 

 

• With Mode: Manual IP address, the module is identified using the IP address that is entered manually in the 
IP address text box (in which case, the Serial number is effectively ignored). 

NOTE: In VibroSight Protect, the IP address text box is used to display the IP address 
(Mode: Automatic discovery from serial number) or enter the IP address 
(Mode: Manual IP address) to be used for communication with a VM600Mk2 
module – but it cannot be used to change an IP address. 
VibroSight System Manager is used to change the IP address of VM600Mk2 
modules, as required by an application.  
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For VM600Mk2 AMC10Mk2 + IOC10Mk2 modules 

When a Channel is selected for a VM600Mk2 AMC10Mk2 + IOC10Mk2 module by clicking on it (in a functional group, 
left) and the channel is not yet configured, a Configuration of a Channel window is displayed that guides the user 
through the configuration of the channel in terms of: 

• Processing type: single-channel, dual-channel or muti-channel. 

• Processing function (based on sensor family), including: 

o Single-channel: 

 Position processing for Proximity probes 

 Quasi-static pressure processing for Pressure sensors 

 Quasi-static temperature processing for Temperature sensors 

 Custom quasi-static processing for Other sensors. 

o Dual-channel: 

 Delta quasi-static pressure processing for Pressure sensors 

 Delta quasi-static temperature processing for Temperature sensors 

 Mathematical function processing for Any/Other sensors. 

o Multi-channel: 

 Temperature aggregation processing for Temperature sensors. 

• Input signal: From a library of sensors / measurement chains. 

Note: The default library (global sensors catalog) can be expanded by editing sensors / measurement chains 
and/or adding new ones (vibro-meter ® or third-party), as required. 

NOTE: For information on configuring temperature sensors / measurements chains such 
as RTDs, thermocouple temperature sensors and other non-linear sensors defined 
by polynomial coefficients, see also 2.6 VibroSight Capture and non-linear sensors 
/ measurement chains. 

 

Once the Channel is configured, the information for the channel is displayed in a series of tabs (General, 
Processing, Alarms, Full display range). 

When a Channel is selected for a VM600Mk2 AMC10Mk2 + IOC10Mk2 module by clicking on it and the channel is 
already configured, the information for the channel is displayed in a series of tabs (General, Processing, Alarms, 
Full display range). 

For each Channel, the General, Processing, Alarms and Full display range tabs must be edited in the main window 
(centre) to configure the parameters and functionality for the channel, as required by the application. See Figure 5. 
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Similarly, when a Logical function, Relay or Analog output is selected for a VM600Mk2 AMC10Mk2 + IOC10Mk2 
module by clicking on it (in a functional group, left), the information and parameters for the feature are displayed in 
the main window (centre), where they must be edited, as required by the application. 

NOTE: As the configuration for a VM600Mk2 system is being developed, the 
Consistency Check window (bottom) should be used to help correct any 
configuration errors and warnings as they occur, thereby helping ensure that a 
valid configuration is arrived at.  

 

 

Activating a configuration on a VM600Mk2 system 

Once a configuration has been created and/or changed, and there are no consistency check errors, the 
configuration must be uploaded to the VM600Mk2 system in order to actually run on the system hardware, 
for example, a VM600Mk2/VM600 rack containing a VM600Mk2 AMC10Mk2 + IOC10Mk2 module. 

The File > System activation command is used to upload the complete VM600Mk2 system configuration currently 
active/loaded in VibroSight Protect to the system hardware. 

As part of the system activation process, VibroSight Protect will upload each individual VM600Mk2 module in turn 
with its part of the complete VM600Mk2 system configuration, then read back each individual module configuration in 
order to check it against the complete VM600Mk2 system configuration again, thereby ensuring that the 
configuration was uploaded to each individual module correctly. 

Once this check is complete, VibroSight Protect will prompt the user to continue (“Proceed”). 

 

After the user has clicked Proceed, VibroSight Protect will: 

• Archive the running configuration 
(in case it needs to be reverted to should something go wrong with the activation of the configuration). 

• Activate the current configuration. 

• Run with the new configuration. 

Once configured, VibroSight Protect will inform the user with a “Success!” message. 

This is shown in Figure 6. 
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Figure 6: VibroSight Protect system activation – upload, check and activation 
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Please note that when activating a configuration on a VM600Mk2 system: 

• All of the modules contained in the configuration must be available at the same time. More specifically, all 
VM600Mk2 modules must be connected to and available on the same network as the computer running 
VibroSight Protect. (This is typically done using a network switch.) 

• When a configuration is uploaded to a VM600 rack, a VM600Mk2 module will restart after receiving the 
configuration in order to enter its power-up mode and perform a power-on self-test (POST), thereby helping to 
ensure that the configuration is correct and valid. 

Note: When a AMC10Mk2 module resets, it temporarily enters the Power-up mode where it takes approximately 
25 seconds to boot and complete its power-on self-test (POST). After a successful POST, the module 
automatically enters the Operational mode if machinery protection firmware is available or enters the Recovery 
mode if machinery protection firmware is not available. 

• After successfully booting, a VM600Mk2 AMC10Mk2 module will jump to its operational mode and start to provide 
measurement data, in accordance with its configuration. 

 

 

VibroSight Protect user interface – Dashboard tab/page 

The Dashboard tab/page is used to operate and manage the VM600Mk2 system, that is, a system that is running a 
configuration. 

An example for a VM600Mk2 AMC10Mk2 + IOC10Mk2 module is shown in Figure 7. 

 

   

Figure 7: VibroSight Protect Dashboard tab/page 
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For VM600Mk2 AMC10Mk2 + IOC10Mk2 modules, the functionality available from the VibroSight Dashboard tab/page, 
includes includes measurement information, control inputs and status information such as: 

• Channel measurement values, data quality information, and sensor OK check. 

• Module status information (Running, Locked or Unlocked), and controls (Lock/Unlock card). 

• Alarm controls: Trip multiply (TM), Alarm bypass (AB), and individual channel bypasses. 

• Relays and analog output information. 

 

 

VibroSight System Manager and VM600Mk2 systems 

For VM600Mk2 systems, VibroSight System Manager is used for general management of VM600Mk2 modules, such 
the VM600Mk2 AMC10Mk2 + IOC10Mk2 module. This includes the display of useful system information for modules. 

This is shown in Figure 8. 

 

In VibroSight System Manager, in the System Explorer window (left), VM600Mk2 AMC10Mk2 + IOC10Mk2 modules are 
listed under AMC10 modules (see Figure 8). 

In general, for VM600Mk2 modules in VibroSight System Manager, functionality is available from the Actions window 
(right) and general information is displayed in the main window (centre). 

For example, as shown in shown in Figure 8 (centre), under General Information, this includes module part 
numbers (PNRs), serial numbers (SNRs), the VM600Mk2/VM600 rack position/slot number, the status of the 
machinery protection and condition monitoring running on the module, etc. 
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Figure 8: VibroSight System Manager information and actions for a AMC10Mk2 module 

 

For the VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module, as per MPC4Mk2 modules, the 
main operating mode of the module is the Operational mode (“Machinery protection status: Running”), which has 
two modes: 

• Locked (safety/secure operating mode) 
When Locked, a AMC10Mk2 module (VM600Mk2 MPS) performs its monitoring and protection functions while 
ensuring the security of the modules/system and it’s configuration. That is, the configuration cannot be 
changed and maintenance activities cannot be performed. 

• Unlocked (maintenance operating mode) 
When Unlocked, a AMC10Mk2 module (VM600Mk2 MPS) performs its monitoring and protection functions without 
ensuring the security of the modules/system and it’s configuration. That is, the configuration can be changed 
and maintenance activities can be performed. 

NOTE: In general, physical access to a VM600Mk2 system (specifically, the buttons on the 
front panel of VM600Mk2 module) is required in order to change the operating mode 
and therefore to be able to change the machinery protection (MPS) functionality for 
a VM600Mk2 system. 
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The Lock state is shown under General information (see Figure 8), as part of the Machinery protection status. For 
example: …, Unlocked or …, Locked. 

NOTE: VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring modules also 
support the new remote unlocking feature, as per the VM600Mk2 MPC4Mk2 + 
IOC4Mk2 machinery protection and condition monitoring module. See 2.2 VibroSight 
Protect and remote unlocking of the VM600Mk2 MPC4Mk2 module. 

 

Figure 8 (Actions window, right) also shows the various actions/tasks that VibroSight System Manager can perform 
for AMC10Mk2 modules, notably: 

• Maintenance: Changing firmware, testing (blinking) front panel LEDs, running a protection test, clearing a 
configuration, and unlocking a module. 

• Configuration: Configuration of IP and NTP settings, setting a “remote unlock” password for a module. 

• Diagnostics: Download of diagnostics log files from a module. 

• Licensing: Managing licensing for a module. 

For VM600Mk2 AMC10Mk2 + IOC10Mk2 modules, both machinery protection and condition monitoring functionality 
are available by default. That is, all AMC10Mk2 modules have condition monitoring enabled, that is, they are 
supplied with a AMC10Mk2 CMS license pre-installed.) 

Note: AMC10Mk2 condition monitoring also requires a VibroSight ® software edition / license that supports 
condition monitoring. 

 

 

VM600Mk2 AMC10Mk2 + IOC10Mk2 module factory assigned defaults 

Unless already configured as part of a VM600Mk2 solution, VM600Mk2 AMC10Mk2 + IOC10Mk2 modules are supplied 
with the following factory assigned defaults: 

• Communications: LAN (Ethernet) port configured as Enabled using dynamic addressing (DHCP). 

• Firmware: Loaded with latest version of Recovery firmware (640-038-vvv-ppp.Amc10Fw) only. 

Accordingly, the LAN (Ethernet) port must be configured to meet your communication requirements and the latest 
version of the machinery protection and condition monitoring firmwares (640-040-vvv-ppp.Amc10Fw and  
640-042-vvv-ppp.VxeFw) must be uploaded. 

See also 2.16 AMC10Mk2 + IOC10Mk2 module firmware. 

Note: Both of these tasks are performed using VibroSight System Manger, as per other VM600Mk2 modules. 
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2.2 VibroSight Protect and remote unlocking of the VM600Mk2 MPC4Mk2 module 

For the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, the main operating 
mode of the module is the Operational mode, which has two modes: 

• Locked (safety/secure operating mode) 

When Locked, a MPC4Mk2 module (VM600Mk2 MPS) performs its machinery protection functions while ensuring 
the security of the module/system and it’s configuration. That is, the configuration cannot be changed, and 
maintenance activities cannot be performed. 

• Unlocked (maintenance operating mode) 

When Unlocked, a MPC4Mk2 module (VM600Mk2 MPS) performs its machinery protection functions without 
ensuring the security of the module/system and it’s configuration. That is, the configuration can be changed, 
and maintenance activities can be performed. 

NOTE: For the standard version of the MPC4Mk2 + IOC4Mk2 module, machinery is protected 
when the MPC4Mk2 module’s main operating mode is Locked or Unlocked. 

For the SIL version of the MPC4Mk2 + IOC4Mk2 module, machinery is protected only 
when the MPC4Mk2 SIL module’s main operating mode is Locked. 
That is, in safety-related applications, a MPC4Mk2 SIL module module can only run 
in the Locked state. 

 

In general, physical access to a MPC4Mk2 module is required in order to change the Operational mode (from 
Locked to Unlocked, and vice versa), as this is typically done using button 2 on the front panel of the module. 

To switch between the two modes: 

• When Locked (safety/secure operating mode), press button 2 (right) 5 times within 5 seconds to switch to 
Unlocked. 

Note: When a standard or SIL MPC4Mk2 module is Locked, the LOCK LED on the front panel of the module is 
solid green. 

• When Unlocked (maintenance operating mode), press and hold button 2 (right) for at least 1 second to switch 
to Locked. 

Note: When a standard MPC4Mk2 module is Unlocked, the LOCK LED on the front panel of the module 
blinks/flashes green. When a SIL MPC4Mk2 module is Unlocked, the LOCK LED on the front panel of the 
module is solid red. 

 

In addition to the LOCK LED, the VibroSight software also indicates the mode of a MPC4Mk2 module: 

• In VibroSight System Manager, when the module is selected (left), in the main window (centre), under 
General information, Machinery protection status will show either …, Locked or …, Unlocked, as appropriate. 

• In VibroSight Protect, on the Dashboard tab/page, in the main window (centre), Module status (right) will show 
either Locked or Unlocked, as appropriate. 
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Starting with VibroSight 7.8.0 and the latest MPC4Mk2 module firmware(s), it is now also possible to remotely unlock 
a MPC4Mk2 module using the VibroSight software (that is, change the Operational mode from Locked to Unlocked) 
without physical access to the module. 

 

However, it is important to note that a “remote unlock” password must have been set for the MPC4Mk2 module 
before remote unlocking can be used. This is a important security feature that helps prevent accidental or 
unauthorized use of MPC4Mk2 module remote unlocking. 

NOTE: Before remote unlocking can be used with a MPC4Mk2 module, a “remote unlock” 
password must have been set for the module, which is done using VibroSight 
System Manager. 

 

 

To set a “remote unlock” password for a MPC4Mk2 module: 

• Put the MPC4Mk2 module in to Recovery mode, as this is required in order to set a “remote unlock” password: 
o Press and hold both button 1 (left) and button 2 (right) for at least 2 seconds to reset (reboot) the 

module, then release button 2 while keeping button 1 pressed for a further 5 seconds. 

Note: When a standard or SIL MPC4Mk2 module is in Recovery mode, the LOCK LED on the front 
panel of the module blinks/flashes red, green, red, green … . 

NOTE: It is important to note that entering the Recovery mode automatically clears the 
module’s configuration (including any previously set “remote unlock” password), 
which means that the module (system) must be reconfigured after leaving the 
Recovery mode – before normal system operation can be resumed. 

 

• In VibroSight System Manager, in the System Explorer window (left), Devices, select the module. 

• In the main window (centre), under General information, Machinery protection status will show 
Recovery, Unlocked. 

• In the Actions window (right), under Configuration, select Remote unlock password. 

• In the Remote unlock password set window, select Enabled, then enter and confirm the password. 

Note: The password must be at least 22 characters long and include a combination of uppercase and 
lowercase letters, numbers and special characters. 

• Return the MPC4Mk2 module to Operational mode: 

o For example, press and hold both button 1 (left) and button 2 (right) for at least 2 seconds to reset 
(reboot) the module. 

Note: When a MPC4Mk2 module resets, it temporarily enters the Power-up mode where it takes 
approximately 25 seconds to boot and complete its power-on self-test (POST). After a successful 
POST, the module automatically enters the Operational mode if machinery protection firmware is 
available or enters the Recovery mode if machinery protection firmware is not available. 
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A MPC4Mk2 module can be remotely unlocked using VibroSight System Manager or VibroSight Protect. 

 

In VibroSight System Manager: 

• In the System Explorer window (left), Devices, select the module. 

• In the main window (centre), under General information, Machinery protection status will show …, Locked. 

• In the Actions window (right), under Maintenance, click Unlock device. 

• In the Unlock device window, enter the (“remote unlock”) password, then click Next. 

• VibroSight System Manager will update to display a message confirming when the MPC4Mk2 module is 
unlocked, and in the main window (centre), under General information, Machinery protection status will show 
…, Unlocked. 

NOTE: Please note that VibroSight System Manager can be used to remotely unlock a 
MPC4Mk2 module (password protected) only. 

 

In VibroSight Protect: 

• On the Dashboard tab/page, select the module (rack view, top). 

• In the main window (centre), Module status (right) will show Locked, and the Unlock card control. 

• Under Module status (right), click the Unlock card control. 

• In the MPC4 card unlock window, enter the (“remote unlock”) password, then click OK. 

• Module status (right) will update to show Unlocked, and the Lock card control. 

NOTE: Please note that VibroSight Protect can be used to remotely unlock a 
MPC4Mk2 module (password protected) and remotely lock a MPC4Mk2 module (not 
password protected). 

 

 

2.3 VibroSight Capture and machine train orientation 

In VibroSight Capture, on the Machinery tab/page that is used to build/draw machine trains in order to help 
organize and visualize the measurements and the machinery being monitored, the design and handling of machine 
trains and machinery components has been improved such that it is now possible to represent vertical machines 
and/or horizontal machines more easily and accurately – in order to better reflect the reality of the machinery being 
monitored. 

(Previously, only horizontal machine trains were permitted but they can now be configured as either horizontal or 
vertical, as determined by an application.) 
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For example, in VibroSight Capture, on the Machinery tab/page: 

• In the Machine train properties window (left), the Layout control is now used to select the orientation of the 
machine train as either Horizontal (the default) or Vertical. 

• Depending on the selected orientation (Layout: Horizontal or Vertical), when the “+” (connection point) control 
is used to add a new machinery component to the machine train, the orientation of the machinery component 
will automatically be adapted to match the layout. 

• At any time, the Layout control (left) can be used to change the orientation of the layout from horizontal to 
vertical (and vice versa) and the machine train and machinery components will automatically be adapted to 
match. 

 

In general, for the new vertical orientation (layout) of machine trains: 

• Machinery components shall be rotated 90° clockwise and displayed as a column instead of as a row. 
• Bearings shall be numbered incrementally from top to bottom. 
• Machine names shall be displayed horizontally to the right of the machine train. 
• The machine train name shall be displayed horizontally on the top of the machine train. 
• Sensor position indicators shall be displayed to the left of the machine train and shall NOT be rotated. For 

example a sensor located at 0° EU shall be displayed on the top of the sensor position indicator in a horizontal 
or in a vertical machine train. 

• Elements that are on top of the horizontal machine train shall be displayed on the left in the vertical machine 
train. For example:  

o Machine name 
o Sensor position indicator 
o Tacho sensor. 

• Elements that are on the bottom of the horizontal machine train shall be displayed on the right in the vertical 
machine train. For example: 

o Connecting processing list 
o Toolbar. 

 

Further, the orientation (layout) of machine trains as drawn in the Machinery tab/page will also be used for the 
same machine trains in the Connect tab/page. 

 

 

2.4 VibroSight Capture and machinery component flipping 

In VibroSight Capture, on the Machinery tab/page that is used to build/draw machine trains in order to help 
organize and visualize the measurements and the machinery being monitored, the design and handling of certain 
machinery components has been improved such that it is now possible to “flip” some machinery components – in 
order to better reflect the reality of the machinery being monitored. 
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More specifically, certain machinery components can now be flipped (or reversed), as follows: 

• In a machine train with a horizontal orientation (Layout: Horizontal), flipping a machinery component will redraw 
the component flipped though a vertical axis (effectively a mirror image). 

• In a machine train with a vertical orientation (Layout: Vertical), flipping a machinery component will redraw the 
component flipped though a horizontal axis (effectively turned upside down). 

 

The flippable machinery components include the following: 

• Machines, Steam turbine: 
o Single flow 
o HP-IP. 

• Bearings: 
o Axial journal bearing 
o Axial rolling bearing. 

• Shafts: 
o Single taper. 

 

To flip a machinery component: 

• In VibroSight Capture, on the Machinery tab/page, use the “+” (connection point) control to add a flippable 
machinery component to a machine train. 

• In the machine train, click the machinery component to select it and a pop-up context menu will appear beside 
the component, as follows: 

o For a flippable machinery component, the menu is: . Note the Flip control (right): . 

o While for a non-floppable machinery component, the menu is: . 
• On the pop-up context menu, click the Flip control to flip the machinery component. 

 

 

2.5 VibroSight Capture and reference speeds 

In VibroSight Capture, a reference speed can be configured for a machine train in order to nominate a speed input 
from a tacho channel that is to be used as the speed reference by signal processing that requires such an input (for 
example, a VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module auxiliary input). 
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To configure a reference speed: 

• In VibroSight Capture, on the Machinery tab/page, build/draw a machine train. 
• On the Systems tab/page, import a system (for example, from a VibroSight Protect configuration/system). 
• On the Connect tab/page, connect the measurement points (from the system) to the machine train. 

When a speed input from a tacho channel (that is, a VM600Mk2 MPC4Mk2 + IOC4Mk2 module auxiliary input) is 
connected to the machine train, the user will be prompted to use this speed input as the reference speed for 
the machine train. 

If the user confirms, then VibroSight Capture will configure and use the speed input as the reference speed for 
the machine train. 

 

In the Machine train properties window (left), the Reference speed control displays the speed input used as the 
reference speed for the machine train, if one has been configured. 

In the Machine train properties window, the Reference speed control can also be used to delete or change the 
reference speed, as required. 

 

In VibroSight 7.8.0, the main new feature related to VibroSight Capture and reference speeds is that now, when a 
reference speed is configured for a machine train, VibroSight Capture will automatically use that reference speed 
as the speed reference for any signal processing that requires it. 

In practice, this means that on the Configure tab/page, where the condition monitoring processing is configured, for 
any condition monitoring that requires a speed reference, the Reference speed control will automatically be 
configured to use the reference speed configured for the machine train. For example, Shaft relative vibration, 
Bearing absolute vibration, Combustion dynamics and Custom dynamic processing. 

(Previously, even if a reference speed was configured for the machine train, the Reference speed control(s) still 
had to be manually configured for each and every condition monitoring processing that required it.) 

 

 

2.6 VibroSight Capture and non-linear sensors / measurement chains 

In VibroSight Capture, it is now possible to configure a sensor / measurement chain with a non-linear sensitivity 
curve / characteristic. 

More specifically, a range of non-linear sensors / measurement chains can now be configured for the “Temperature 
sensors” family as used by the Quasi-static temperature processing, and for the “Other sensors” sensor family as 
used by the Custom dynamic and Custom quasi-static processing. 

 

Linear sensitivities 

Previously, it was only possible to configure a sensor / measurement chain with a linear sensitivity curve / 
characteristic, that is, equivalent to the now default setting of Sensitivity curve: Linear. 

With Sensitivity curve set to Linear, the Sensitivity curve is shown as a straight line, and the characteristics of the 
sensor / measurement chain are defined by using the controls shown in the sensitivity curve to specify the 
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sensitivity (output (V or I) / physical quantity units) and the linear part of the measurement range (in terms of both 
output (V or I) and physical quantity units. 

 

Non-linear sensors defined by polynomial coefficients 

When working with non-linear sensors defined by polynomial coefficients, it is now possible to configure the 
Sensitivity curve as Non-linear and define the sensor in terms of polynomial coefficients. 

(Previously, it was only possible to configure a sensor / measurement chain with a linear sensitivity curve / 
characteristic, that is, equivalent to the now default setting of Sensitivity curve: Linear.) 

With Sensitivity curve set to Non-linear, the Sensitivity curve is shown as a curved line, and the characteristics of 
the sensor / measurement chain can be defined in a number of different ways, depending on the sensor type. 

For Sensor type(s) Voltage output and Current output, in the sensitivity curve, the drop-down menu is shown as 
Custom and clicking on the “Sensitivity” control in the curve presents the Non-linear sensitivity window. 

In the Non-linear sensitivity window: 

• The Electrical unit and Engineering unit controls (top) are used to define the output voltage or current units and 
the physical quantity units for the sensor / measurement chain. 

• The Polynomial coefficients table is used to define the non-linear curve for the sensor / measurement using 
one to four polynomial curves (where each polynomial will correspond to a specific region of the curve): 

o Each polynomial curve shall be configured providing the input range and the polynomial coefficients. 
o Each polynomial curve can have 1 to 11 coefficients (C0 to C10), as follows: 

Y = G × (C0 + C1X + C2X2 + C3X3 + ... + CnXn) 

where 

X is the input (for instance, ohms or volts), 

Y is the output (for instance, temperature), 

Cn are the polynomial coefficients, 

G is the output gain. 

 

NOTE: The user shall be able to configure polynomials of a maximum grade of 10. 

 

• The Add control is used to add additional curves. Alternatively, the Import and Export controls can be used 
to import / export defined polynomial curves in the CSV (comma separated values) file format, for example 
using Excel or equivalent. 

• The Sensitivity polynomial curve automatically updates to show the non-linear sensitivity of the sensor / 
measurement chain, as defined by the data entered in the polynomial coefficients table. 
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Non-linear RTD temperature sensors 

When working with non-linear temperature sensors such as RTDs (resistance temperature detector), it is now 
possible to configure the Sensitivity curve as Non-linear and either use one of the predefined RTD characteristic 
curves or define a custom characteristic curve (in terms of polynomial coefficients). 

With Sensitivity curve set to Non-linear, the Sensitivity curve is shown as a curved line, and the characteristics of 
the sensor / measurement chain can be defined in a number of different ways, depending on the sensor type. 

For RTD Sensor types (2-wire RTD, 3-wire RTD or 4-wire RTD), in the sensitivity curve, the drop-down menu can 
be used to select one of the following pre-defined types of RTD sensor: PT100-385, PT100-392, CU10-427, NI120-
672. 

Alternatively, in the sensitivity curve, the drop-down menu can be used to select Custom and the “Sensitivity” 
control in the curve can be used to define a custom non-linear curve (as described in “Non-linear sensors defined 
by polynomial coefficients” above). 

 

Non-linear Thermocouple temperature sensors 

When working with non-linear temperature sensors such as thermocouples, it is now possible to configure the 
Sensitivity curve as Non-linear and either use one of the predefined thermocouple characteristic curves or define a 
custom characteristic curve (in terms of polynomial coefficients). 

With Sensitivity curve set to Non-linear, the Sensitivity curve is shown as a curved line, and the characteristics of 
the sensor / measurement chain can be defined in a number of different ways, depending on the sensor type. 

For Thermocouple Sensor types (Thermocouple), in the sensitivity curve, the drop-down menu can be used to 
select one of the following pre-defined types of Thermocouple sensor: TC type E, TC type J, TC type K, TC type T. 

Alternatively, in the sensitivity curve, the drop-down menu can be used to select Custom and the “Sensitivity” 
control in the curve can be used to define a custom non-linear curve (as described in “Non-linear sensors defined 
by polynomial coefficients” above). 

 

See also 2.1 Support for the VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module. 

 

 

2.7 VibroSight Capture, axial journal bearings and VM600Mk2 MPC4Mk2 module shaft axial 
position processings 

In VibroSight Capture, on the Connect tab/page that is used to associate/connect processing blocks/functions to 
machine train components in order to help organize and visualize the measurements and the machinery being 
monitored, it is now possible to connect the different types of shaft axial position processing supported by 
VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules to axial journal bearings in a 
machine train. 
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More specifically, the following VM600Mk2 MPC4Mk2 + IOC4Mk2 module shaft axial position processings (configured 
in VibroSight Protect) can now be connected to axial journal bearings (configured in VibroSight Capture): 

• Single-channel processing: 
o Shaft axial position (collar (method)) 
o Shaft axial position (shaft end (method)). 

• Dual-channel processing: 
o Shaft axial position (collar (method)) 
o Shaft axial position (shaft end (method)). 

NOTE: In VibroSight Capture, on the Connect tab/page, when a machine train component 
is selected (top) and a processing channel (single or dual) is selected (bottom), the 
“Connect” control is displayed if the two are compatible and can be 
associated/connected. Otherwise, “The processing of a selected input channel is 
not compatible with the selected machine component” message is displayed. 

 

Note: In a machine train, the number of sensor icons shown against an axial journal bearing reflects the number of 
sensors used by the associated processing, that is, one for single-channel processing, and two for dual-channel 
processing. 

 

(Previously, it was not possible to connect the different types of shaft axial position processing supported by the 
VM600Mk2 MPC4Mk2 + IOC4Mk2 module to axial journal bearings.) 

 

 

2.8 VibroSight Capture, machine train components and VM600Mk2 MPC4Mk2 module position 
processing 

In VibroSight Capture, on the Connect tab/page that is used to associate/connect processing blocks/functions to 
machine train components in order to help organize and visualize the measurements and the machinery being 
monitored, it is now possible to connect the position processing supported by VM600Mk2 MPC4Mk2 + IOC4Mk2 
machinery protection and condition monitoring modules to a wider range of different machine train components in a 
machine train. 

More specifically, the following VM600Mk2 MPC4Mk2 + IOC4Mk2 module processing (configured in VibroSight Protect) 
can now be connected to a wider range of different machine train components (configured in VibroSight Capture): 

• Single-channel processing: 
o Position. 

NOTE: In VibroSight Capture, on the Connect tab/page, when a machine train component 
is selected (top) and a processing channel (single or dual) is selected (bottom), the 
“Connect” control is displayed if the two are compatible and can be 
associated/connected. Otherwise, “The processing of a selected input channel is 
not compatible with the selected machine component” message is displayed. 
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The range of different machine train components that position processing can now be connected to includes the 
following: 

• Generic machines: Rectangle, Square, Circle, Trapezoid. 
• Steam turbine: Single flow, Double flow, HP-IP. 
• Hydro turbine: Francis, Kaplan, Pelton. 
• Pump: Centrifugal, Multi-stage. 
• Generator: Compact, Large. 
• Compressor: Reciprocating 2 throw, Reciprocating 4 throw, Reciprocating 6 throw. 
• Bearings: Radial journal bearing, Axial journal bearing. 
• Gearbox: Single-stage, Multi-stage. 

 

Note: A previous limitation of one position processing per machine train component was removed so it is now 
possible to associate/connect multiple position processings with a single machine train component. Accordingly, in 
a machine train, the number of sensor icons shown against a machine train component reflects the number of 
associated processings, that is, one for one processing, two for two processings, and so on. 

 

(Previously, it was not possible to connect the position processing supported by the VM600Mk2 MPC4Mk2 + IOC4Mk2 
module to such a wide range of different machine train components. And where possible, it was only allowed to 
connect one position processing per machine train component.) 

 

 

2.9 VibroSight Capture, steam-turbine machine train components, valve regions and 
VM600Mk2 MPC4Mk2 module position processing 

In VibroSight Capture, on the Connect tab/page that is used to associate/connect processing blocks/functions to 
machine train components in order to help organize and visualize the measurements and the machinery being 
monitored, it is now possible to connect a range of processings supported by VM600Mk2 MPC4Mk2 + IOC4Mk2 
machinery protection and condition monitoring modules to new specific “valve regions” of the steam-turbine 
components in a machine train. 

More specifically, the following VM600Mk2 MPC4Mk2 + IOC4Mk2 module processings (configured in VibroSight 
Protect) can now be connected to these new valve regions of the steam-turbine components (configured in 
VibroSight Capture): 

• Single-channel processing: 
o Position 
o Quasi-static pressure 
o Quasi-static temperature 
o Custom dynamic 
o Custom quasi-static. 

• Dual-channel processing: 
o Mathematical function. 
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NOTE: In VibroSight Capture, on the Connect tab/page, when a machine train component 
is selected (top) and a processing channel (single or dual) is selected (bottom), the 
“Connect” control is displayed if the two are compatible and can be 
associated/connected. Otherwise, “The processing of a selected input channel is 
not compatible with the selected machine component” message is displayed. 

 

The range of steam-turbine components with the new valve regions that processings can now be connected to 
includes the following: 

• Single flow 
• Double flow 
• HP-IP. 

 

In VibroSight Capture, on the Connect tab/page, when connecting a steam-turbine component with valve regions 
(top) with a compatible processing (bottom), a Processing function location window is now automatically displayed 
in order to allow the function/position of the sensor icon shown against a steam-turbine component to be assigned 
to one of the following “regions”: 

• No specific location 
• Control valves 
• Stop valves. 

 

In a machine train, when Control or Stop valves regions are used, the sensor icon(s) are now shown against a 
valves image added to the top of the steam-turbine component, as follows: 

• Valves image (general): . 

 

• Control valve: . 
 

 

• Stop valve: . 

 

Accordingly, in a machine train, when a steam-turbine component with valve regions is used: 

• For sensors assigned to No specific location – the sensor icon(s) are shown below the machine component (as 
before). 

• For sensors assigned to Control valves – the sensor icon(s) are shown against the control valve (bottom) in the 
valves image. 

• For sensors assigned to Stop valves – the sensor icon(s) are shown against the stop valve (top) in the valves 
image. 
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(Previously, it was not possible to connect processings supported by the VM600Mk2 MPC4Mk2 + IOC4Mk2 module to 
“valve regions” of steam-turbine components – as valve regions were only introduced in VibroSight 7.8.0.) 

 

 

2.10 VibroSight and OPC UA NodeIds 

The VibroSight software includes support for OPC UA (unified architecture) so that a VibroSight Server can easily 
export data from a VibroSight Server (VibroSight historical data folder (*.vshdf)) to third-party systems such as a 
DCS, PLC or data analysis tools. 

NOTE: No specific configuration procedure is required in order to use OPC UA with 
VibroSight, that is, it is not necessary to manually create, save and publish a 
separate VibroSight OPC server. 

Instead VibroSight automatically creates an OPC UA server for all of the data 
available in a VibroSight Server (live and historical, static and dynamic) when 
OPC UA server is enabled in the VibroSight Server user interface (that is, 
OPC UA server enabled under Server features and OPC / OPC UA enabled under 
Device drivers) . 
More specifically, the OPC UA server is embedded in the VibroSight Server 
(Xms.Server.Client.exe). 

 

OPC UA uses NodeIds – unique identifiers for the nodes in the address space of an OPC UA server. 
Accordingly, to ensure stability and usability of the OPC UA interface, VibroSight’s implementation of OPC UA has 
recently been improved to ensure that NodeIds (measurements) are more consistent/persistent across restarts and 
configuration changes. 

More specifically, a “persistent dictionary” has been implemented in order to store a stable mapping between 
measurements and their corresponding OPC UA NodeIds. And the dictionary is reused on each server start to 
ensure consistent NodeId allocation. 

For example, NodeIds for unchanged measurements remain the same across configuration changes, and new 
measurements are assigned new NodeIds without affecting existing ones. Removed measurements are no longer 
served via OPC UA, but remaining ones retain their previous NodeIds. Edge cases such as ID collisions, 
configuration import/export, and recovery from corrupted mappings are also handled. 

 

(Previously, VibroSight’s OPC UA NodeIds were generated dynamically each time the OPC UA server started, 
based on the order of measurements in the configuration. As a result, when a system configuration changed 
(for example, by adding or removing a measurement in the VibroSight Capture configuration), NodeIds shifted, 
causing clients to lose access to previously subscribed measurements – which required that their OPC UA client 
was updated in order to regain access.) 
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2.11 VM600Mk2 systems, VibroSight Capture and CSV data source import 

For Vibrosight VM600Mk2 systems, VibroSight Capture is used to configure the system interfaces associated with a 
VibroSight database/system, such as: 

• A VibroSight Protect configuration – used as the basis for a VibroSight Capture configuration. 

NOTE: It is important to note that when using VibroSight Capture to configure a VM600Mk2 
system for condition monitoring, the condition monitoring (CMS) configuration 
builds on the existing machinery protection (MPS) configuration, as defined using 
VibroSight Protect. 

 

And now … 

• CSV data source (comma-separated values files) – used for external data file import. 

NOTE: CSV files can be imported into a local VibroSight Server (*.vshdf) in order to 
allow data from third-party systems such as other monitoring systems and/or 
control systems (DCS or PLC) to be easily incorporated, and take advantage of the 
speed and power of VibroSight for machinery monitoring, remote monitoring and 
diagnostics. 

 

NOTE: A CSV file is a comma-separated values file, that is, a delimited text file text that 
uses commas to separate values. CSV files are typically used to share 
(import/export) data between programs that store data in tables, such as databases 
or spreadsheets. 

 

Data imported from CSV files can be displayed live in VibroSight Vision and/or it can be logged to the VibroSight 
Server (database). Once imported into a VibroSight Server (VibroSight historical data folder (*.vshdf)), data from 
third-party systems is considered as VibroSight data and is handled and treated in exactly the same way. For 
example, the data can be displayed and analysed using VibroSight Vision, and so on. 

 

 

NOTE: Just like all of the other measurement data available in a VibroSight monitoring 
system, data imported from CSV files can be logged into a VibroSight Server 
(database) so that it remains available as historical data − by simply configuring 
data logging rules for the imported CSV data entities in VibroSight Protect. 
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Importing data from CSV files into a VibroSight Server (database) is particularly useful when: 

• Users are migrating from an existing machinery monitoring system to VibroSight and they want to access the 
legacy system data using VibroSight. 

• Users want to use the speed and power of VibroSight data for the display and analysis and of all of their plant-
wide data. 

• Users want to centralise data from multiple different systems in a single VibroSight Server (database) for ease 
of data management. 

 

 

In VibroSight Capture, to use a CSV data source to import data into a VibroSight database/system: 

 

• Use the Systems tab/page to add the CSV data source interface. 

In the main window (centre), click on the “+” (add a system) box to display the new system window, then select 
a CSV data source to add the interface device, as required. 
The CSV data source icon is added to the Systems tab/page. 

 

• On the Systems tab/page, configure the CSV data source interface. 

In the main window (centre), click on the CSV data source icon to select it. 
The CSV data source parameters are displayed in the main window (centre) and can be edited as required. 

Note: At any time, clicking on Return to systems (main window, centre, top right) will return to the main (home) 
view of the Systems tab/page. 

Configuring a CSV data source requires that the following parameters are configured: 

• Enabled, Name, Description, Input directory, Remove CSV files after processing, Remove invalid CSV files, 
CSV separator, Time zone, File encoding, Timestamp column, Timestamp pattern. 

Where: 

Enabled: A CSV data source is enabled by default but can be disabled, as required. 

Name: Use the default name for the CSV data source or change it, as required. 

Description: Optional text to help describe the configuration/application. 

Input directory: The location of the folder containing the CSV files (for example, *.csv) from the third-party 
system(s). That is, where the CSV data files to be imported will be made available. 
Note: …\External CSV Files is the default but can be changed as required. It can be a folder on the 
computer running the VibroSight Server or a network directory/folder. 

Remove CSV files after processing: When this check box is selected, the VibroSight Server will automatically 
delete a CSV file from the input folder after it has finished processing it. 
Note: It can be useful to see the CSV files in the input folder when initially configuring and working with a 
VibroSight Server. But once the system is working as expected, it is recommended to select this check box to 
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automatically delete them in order to reduce storage requirements (avoiding potential issues such as a disk-full 
situation). 

Remove invalid CSV files: When this check box is selected, the VibroSight Server will automatically delete from 
the input folder any CSV files that are invalid and cannot be processed (for example, corrupted fles). 

CSV separator: Select the character used to separate (delimit) the data in the CSV files. Comma is the default. 

Time zone: Select the time zone (local computer/site time) used by the timestamps in the CSV files. 
UTC (coordinated universal time) is the default. 

File encoding: Select the file encoding (character set) used by the CSV files. 65001 : Unicode (UTF-8) is the 
default. 

Timestamp column: Enter the title of the column in the CSV file containing timestamp data. Timestamp is the 
default. 

Timestamp pattern: Enter the syntax of timestamp data used by the CSV files, where: 
dd is the day (as a number from 01 through 31; a single-digit day is formatted with a leading zero), 
MM is the month (as a number from 01 through 12; a single-digit month is formatted with a leading zero), 
yyyy is the year (as a number with a minimum of four digits; if the year has fewer than four digits, the number is 
padded with leading zeros to produce four digits), 
HH is the hour (as a number from 00 through 23, that is, the hour is represented by a zero-based 24-hour clock 
that counts the hours since midnight; a single-digit hour is formatted with a leading zero), 
mm is the minute (as a number from 00 through 59; a single-digit minute is formatted with a leading zero), 
ss is the second (as a number from 00 through 59; a single-digit second is formatted with a leading zero). 
dd.MM.yyyy HH:mm:ss is the default. 

 

Export CSV template file control: 

For a CSV data source, after Tag groups containing the data (tags) to be imported have been configured, a 
template CSV file corresponding to the configured Tag groups and Tags data structure can be exported in 
order to be used as a reference for the creation and population of the real CSV files with data that will be 
imported. This is done using the Export CSV template file control. 

 

• On the Systems tab/page, add Tag groups for data (tags – scalar and/or vector data entities) to the CSV data 
source interface. 

Note: One or more Tag groups are required to contain/organize the data (tags – scalar and/or vector data 
entities) that will be imported. 

In the main window (centre), click on Tag group 1 (left) to select it. 
The Tag group parameters are displayed on the General tab in the main window (centre) and can be edited as 
required. 
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Configuring a Tag group requires that the following parameters are configured: 

• Enabled, Name, Description. 

Where: 

Enabled: A Tag group is enabled by default but can be disabled, as required. 

Name: Use the default name for the Tag group or change it, as required. 

Description: Optional text to help describe the Tag group. 

Note: At any time, clicking on the CSV data source or Tag group n (System window, right) can be used to 
select the CSV data source or Tag group to display on the main (home) view of the Systems tab/page. 

 

 

• On the Systems tab/page, add data (tags – scalar and/or vector data entities) to Tag groups for the CSV data 
source interface. 

In the main window (centre), click on a Tag group (left) to select it. Alternatively, use the System window (right). 
For the selected Tag group, the data (tags) parameters are displayed on the Tags tab in the main window 
(centre) and can be added and configured as required. 

 

To add data (tags) to the Tag group, use the Add control (bottom left) to add a Scalar data entities and/or a 
Vector data entities, as required. 
 

Added data (tags – scalar and/or vector data entities) are displayed on the Tags tab in the main window 
(centre) where they can be edited. 

Note: In the summary view (left), the Enabled column is used to enable or disable a tag, as required. 

 

In the main window (centre), select a tag (scalar or vector data entity) in the summary view (left) and configure 
its parameters (right), as follows: 

Tag name: Use the default tag name for the data entity or change it, as required. 

Quantity: The physical quantity for the data entity (for example, acceleration or velocity or displacement). 

Unit: The unit for the data entity (for example, g or m/s2 when the physical quantity is acceleration). 

Qualifier: The qualifier (rectifier) unit for the data entity (for example, average, RMS or peak). 

Amplitude column: The path name for the amplitude component of a scalar or vector data entity. 
Default is <Processing block name>\<Data entity name>\Amplitude, where the ‘Processing block 
name’ and ‘Data entity name’ depend on parameters configured earlier but ‘Amplitude’ can be changed here 
as required. 

 

Rotation speed column (optional): If required, the path name for the rotational speed data corresponding to the 
data entity. 
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Default is <Processing block name>\<Data entity name>\Speed, where the ‘Processing block 
name’ and ‘Data entity name’ depend on parameters configured earlier but ‘Speed’ can be changed here as 
required.  

Rotation speed unit: The unit for the rotational speed data corresponding to the data entity (rpm or rps). 

Quality column (optional): If required, the path name for the data quality information corresponding to the data 
entity. 
Default is <Processing block name>\<Data entity name>\Quality, where the ‘Processing block 
name’ and ‘Data entity name’ depend on parameters configured earlier but ‘Quality’ can be changed here as 
required.  

Minimum value and Maximum value: Values to be used to display the data entity can also be configured. 

Alarm: A 1D fixed limit alarm for the data entity can also be configured. 

 

In addition, for a vector data entity only, there are: 

Phase qualifier: The phase qualifier (reference) for the phase component of a vector data entity. 

Phase column: The path name for the phase component of a vector data entity. 
Default is <Processing block name>\<Data entity name>\Phase, where the ‘Processing block 
name’ and ‘Data entity name’ depend on parameters configured earlier but ‘Phase’ can be changed here as 
required.  

 

Note: When configuring data parameters, the path names are the actual paths to the effective data columns in 
the CSV files themselves.  

 

Import from CSV and Export to CSV controls: 

In the summary view (left), the Import from CSV and Export from CSV controls can be used to more easily 
add/configure/share data (tags – scalar and/or vector data entities) by using CSV files containing tag data. 
More specifically, after a CSV data source containing one or more tag groups and tags (scalar and/or vector 
data entities) has been configured, a template CSV file corresponding to the configured Tag groups and Tags 
data structure can be exported in order to be used as a reference for the creation and population of the real 
CSV files with data that will be imported. 

 

 

• On the Data tab/page, under Database logging rules, configure the data logging rules for the VibroSight Server 
in the usual way. 

Note: If data logging rules are not configured for the data imported from the CSV data source, then the data will 
be available as live data only. 

 

• On the Data tab/page, under Database backup, Database purge and File storage, configure the integrated data 
management for the VibroSight Server in the usual way. 
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A VibroSight Capture configuration with CSV data source import is saved and activated in the usual way, that is, 
using the File > Save as server and/or the File > Apply changes to active configuration menu commands, as 
appropriate. 

 

Finally, once the VibroSight Server is up and running, the Server feature required by the VSHDA data source (CSV 
import) must be enabled via the server’s user interface, as appropriate. 

 

 

Application tips and tricks 

Use the exported CSV data template file (Import from CSV and Export from CSV controls) as a reference for the 
creation and population of the real CSV files with data that will be imported into VibroSight. 

The optimal Tag groups and Tags structure used to import data from CSV files into VibroSight depends primarily on 
the application and the third-party data source or sources being used. 

For example: 

• A single CSV file, containing both scalar and vector data, could be used for each separate time period to be 
imported. 

• Different CSV files, one containing scalar data and one containing vector data, could be used for each separate 
time period to be imported. 

• Different CSV files, containing scalar and/or vector data for a particular machine or process, could be used for 
each time separate time period to be imported. 

 

However, there is one very important condition to observe when importing data from CSV files into VibroSight, 
namely, that the data must be made available in a strict chronological order. More specifically: 

• In the CSV files themselves, the timestamps (and data) must be in a chronological order. For example: 

Timestamp,Processing Block 1\Scalar Data Entity 1\Amplitude,… 

17.09.2018 14:05:30,10,… 

17.09.2018 14:06:30,15,… 

17.09.2018 14:07:30,13,… 

17.09.2018 14:08:30,20,… 

… 

• The CSV files themselves must be copied to the Input directory (default: …\External CSV Files) in 
chronological order. That is, CSV files containing data with earlier timestamps must be made available and 
imported before CSV files containing data with later timestamps. 

 



 
 
 

 
 
 
 

VibroSight 7.8.0 software release notes 
Document reference VIBROSIGHT-RN/E (660-010-013-241A) 
 

Version 41 – 22.09.2025 
46 / 110 

 

NOTE: When importing data from CSV files into VibroSight, it is important to important to 
make the data available in a strict chronological order. 

This is because VibroSight Server keeps track of the latest (most recent) 
timestamp for each individual data entity and will not allow data earlier than the 
latest (most recent) timestamp to be imported 

 

 

In the VibroSight Server user interface: 

• On the Status tab, under Server features, ensure that CSV import is enabled. 

• On the Status tab, under Server features, ensure that Data logging manager is enabled if the VibroSight Server 
is required to log data (including CSV data source data) to its database. 

Note: If the VibroSight Server is to be used for the display of live data only, then data logging is not required. 

 

 

Once a configuration is activated (applied) to a VibroSight Server and CSV import and Data logging manager are 
enabled, the VibroSight Server is ready to start the import and collation of data from CSV files. 

Note: For the VibroSight Server, the data update rate depends on the availability of the CSV files (for example, 
*.csv) in the input folder monitored by the VibroSight Server. 

 

 

In practice, a VibroSight Server continuously monitors the designated directory/folder (Input directory) for the CSV 
files (for example, *.csv). As the files appear in the designated directory/folder, the VibroSight Server uses the 
timestamps of the files to help organise and sort them before parsing the files and adding the CSV data to its own 
database (VibroSight historical data folder (*.vshdf)). 

The VibroSight Server’s Log messages tab is used to display any messages related to the import of data from CSV 
files into VibroSight, such as problems processing CSV files due to missing or incorrectly formatted data. 

 

 

In VibroSight Vision: 

• Create a new project (File > New project) using VibroSight Server as the data source, then select and connect 
to the VibroSight Server. 

• Use the Time range window to work with live (Live data) or historical (Machine states, Alarms or Custom 
historical) data, as required. 

 

When working with live data, the update rate for the data displayed in a plot depends primarily on how often the 
CSV files are copied to the input folder monitored by the VibroSight Server.  
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When working with historical data, the data displayed in a plot depends primarily on the availability of the imported 
data in the VibroSight historical data folder (*.vshdf) used as the data repository by the VibroSight Server (which 
in turn depends on how often CSV files (for example, *.csv) are copied to the input folder monitored by the 
VibroSight Server and the contents of the CSV files. 

For example, for CSV files covering a time range of 10 minutes that are regularly imported (approximately every 
10 minutes), a historical data plot would display the most recent data in 10 minute “chunks”. 
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VM600Mk2 / VM600 modules 

2.12 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) 

The MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module are 
available in different versions – standard and SIL – as follows: 

• MPC4Mk2 + IOC4Mk2 and RLC16Mk2 – these are the standard versions of the modules, suitable for most 
applications. 
Note: PNRs 600-041 for the MPC4Mk2, 600-043 for the IOC4Mk2 and 600-045 for the RLC16Mk2. 

• MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL – these are the SIL safety versions of the modules, suitable for 
critical applications demanding the highest level of protection. 
Note: PNRs 600-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL and 600-044 for the RLC16Mk2 SIL. 

 

NOTE: It is important to note that the standard (STD) and SIL versions of the 
VM600Mk2 MPC4Mk2 + IOC4Mk2 modules use different firmwares, as follows: 

MPC4Mk2: 
(STD) Machinery protection firmware: 640-025-vvv-pp 
(STD) Condition monitoring firmware: 640-033-vvv-ppp 
(STD) Recovery firmware: 640-031-vvv-ppp 
Protection test firmware: 640-032-vvv-ppp. 

MPC4Mk2 SIL: 
SIL machinery protection firmware: 640-024-vvv-ppp 
SIL condition monitoring firmware: 640-033-vvv-ppp 
SIL Recovery firmware: 640-026-vvv-ppp 
Protection test firmware: 640-032-vvv-ppp. 

The condition monitoring firmware (640-033-vvv-ppp) is intended to be 
common/shared firmware that is used by both the STD and SIL versions of the 
VM600Mk2 MPC4Mk2 + IOC4Mk2 modules. However, due to differences in release 
schedules and because of SIL certification requirements, in practice, it’s often not 
possible to introduce new features while maintaining full compatibility between the 
two modules (and firmwares). 
For example, the latest condition monitoring firmware (640-033-008-ppp, 
version 8.0) introduces a new interface with features that are only available on the 
standard version of the module. But the SIL version of the module still operates 
with the older interface and so continues to use the previous condition monitoring 
firmware (640-033-007-ppp, version 7.0). 

Please note that the protection test firmware (640-032-vvv-ppp) is common/shared 
firmware that is used by both the STD and SIL versions of the VM600Mk2 MPC4Mk2 
+ IOC4Mk2 modules. 

 

See also 2.13 MPC4Mk2 + IOC4Mk2 module firmware and 2.14 MPC4Mk2 + IOC4Mk2 SIL module firmware. 

  



 
 
 

 
 
 
 

VibroSight 7.8.0 software release notes 
Document reference VIBROSIGHT-RN/E (660-010-013-241A) 
 

Version 41 – 22.09.2025 
49 / 110 

 

2.13 MPC4Mk2 + IOC4Mk2 module firmware (standard) 

NOTE: Standard versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 module only 
(that is, PNR 600-041 for the MPC4Mk2). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

(STD) Machinery protection firmware: 640-025-012-000 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-012-000) is 
compatible with both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 
600-041-001-vvv). 

 

New features: 

• A watchdog timer causes the module to reboot/restart if the machinery protection firmware stops operating 
normally. 

• The status of all discrete signal interface (DSI) inputs (alarm bypass (AB), alarm reset (AR) and trip multiply 
(TM)) is reported to a VM600Mk2 CPUMMk2, via the VME bus. 

• Overall module status (diagnostic fault code information) is reported to a VM600Mk2 CPUMMk2, via the VME bus. 

• The alarm bypass (AB) DSI input can be used as an input to a logical function or a relay. 
Note: The DSI alarm bypass (the physical contact) is applied to all channels at the same time. 

• For frequency domain measurements, it is possible to configure the measurements in terms of orders (nX) 
when using fixed-frequency data acquisition, and to configure the measurements in terms of frequency (Hz) 
when using order-tracking data acquisition. 

• Single-channel temperature sensor processing (quasi-static temperature) supports averaging (specifically, 
mean, minimum or maximum). 
Note: The VM600Mk2 MPC4Mk2 module and VM600Mk2 AMC8Mk2 module both support temperature averaging in 
the same way. 

• The average reference speed is now included/provided with all frequency-domain or time-domain 
measurements (waveforms) sent to VibroSight. 
Note: Previously, the instantaneous speed was included/provided which could result in plot errors when using 
doubly-integrated measurement data. 

• Support for the remote unlocking (with password protection) of a module via an “unlock” control in the 
VibroSight software. 

• Adaptive monitoring improvement to correctly handle certain physical quantities, notably temperature 
configured in degrees Celsius (°C). 

• For dual-taper processings (differential expansion and rotor expansion), the ramp angle (α1 and α2) constraints 
have been modified. 
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Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• For differential expansion (collar) processing, the dual sensor OK check (sensor NOK) was not working 
correctly for this dual-channel processing. 

• Module stopped operating normally (crashed) when the NTP server time changed significantly, that is, with 
large jumps in time. 

• Module erased its configuration upon detection of an error class 1 (fatal-level) or 2 (error-level) diagnostic fault 
code during module boot / power-on self-test (POST). 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

(STD) Condition monitoring firmware: 640-033-008-000 

New features: 

• For frequency domain measurements, it is possible to configure the measurements in terms of orders (nX) 
when using fixed-frequency data acquisition, and to configure the measurements in terms of frequency (Hz) 
when using order-tracking data acquisition. 

• The average reference speed is now included/provided with all frequency-domain or time-domain 
measurements (waveforms) sent to VibroSight. 
Note: Previously, the instantaneous speed was included/provided which could result in plot errors when using 
doubly-integrated measurement data. 

• Added support for a third dual-processing channel (in order to help support quad-channel processing such as 
journal bearing vibration (“sleeve bearing vibration”) in VibroSight). 

Bug fixes: 

• Dual-channel data for dynamic channels was returned when data for auxiliary channels was requested 
(depending on the configuration). 

• Shaft absolute vibration processing, which uses shaft relative vibration processing and bearing absolute 
vibration processing, only accepted velocity sensors or velocimeters (requiring single integration) – but will now 
also work with accelerometers (requiring double integration). 

• Shaft absolute vibration processing failing due to lack of synchronisation between the constituent shaft relative 
vibration processing and bearing absolute vibration processing, related to the different levels of integration 
(1 or 2) of the sensor / measurement channel vibration signal that can be required. 

Restrictions: 

• Compatible with the latest (STD) machinery protection firmware (640-025-012-000) and VibroSight 7.8 only. 
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(STD) Recovery firmware: 640-031-008-000 

New features: 

• Support for the remote unlocking (with password protection) of a module via an “unlock” control in the 
VibroSight software. 

Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• Module stopped operating normally (crashed) when the NTP server time changed significantly, that is, with 
large jumps in time. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

Protection test firmware: 640-032-005-000 

NOTE: Please note that the protection test firmware (640-032-vvv-ppp) is the only 
firmware common/shared by the STD and SIL versions of the VM600Mk2 MPC4Mk2 + 
IOC4Mk2 modules. 

 

New features: 

• None. 

Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

Restrictions: 

• Compatible with the latest (STD) recovery firmware (640-031-008-000), the latest SIL recovery firmware (640-
026-003-000) and VibroSight 7.8 only. 

 

See also 6.2 VM600Mk2/VM600 modules (cards). 
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2.14 MPC4Mk2 + IOC4Mk2 SIL module firmware (SIL) 

NOTE: SIL versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 SIL module only 
(that is, PNR 600-040 for the MPC4Mk2 SIL). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 SIL machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

SIL machinery protection firmware: 640-024-002T005 

New features: 

• None. 

Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• Module stopped operating normally (crashed) when the NTP server time changed significantly, that is, with 
large jumps in time. 

• Module sometimes entered fail-safe mode (safe state) after a power off/on cycle (module boot / power-on self-
test (POST)). 

• Module sometimes entered recovery mode (safe state) after a power off/on cycle (module boot / power-on self-
test (POST)) and invalidated the module’s configuration. 

• Module sometimes does not provide data after a power off/on cycle (module boot / power-on self-test (POST)) 
in the unlocked operational mode (maintenance mode), due to an internal (SVP) synchronisation issue. 

• Tacho diagnostics improvements in order to avoid false alarms (that is, tacho related diagnostic fault codes). 
For example, due to how equal signal inputs on both auxiliary channels are characterised in terms of input level 
sensitivity and pulse signal steepness, and/or due to input DC offset changes larger than the tacho signal 
amplitude. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 
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NOTE: It is important to be aware that this latest SIL machinery protection firmware,  
640-024-002T005, is a “beta” release for the future 640-024-002-000 and is 
intended for test and evaluation only. SIL re-certification is pending! 

(Note: 640-024-002T005 also includes the changes from 640-024-002T002 and 
640-024-002T003, which corresponds to all changes that will be available in the 
future 640-024-002-000 – compared to the last official release 640-024-001-000.) 

Since this latest SIL machinery protection firmware (640-024-002T005) is a “beta” 
release, the MPC4Mk2 SIL module cannot be Locked (that is, cannot be put into the 
safety/secure operating mode (of the Operational mode)). 

Firmware upgrades to final versions of SIL-specific firmware will be required before 
a VM600Mk2 SIL system containing MPC4Mk2 + IOC4Mk2 SIL modules can be used in 
critical safety-related applications. 

 

 

(SIL) Condition monitoring firmware: 640-033-007-001 

New features: 

• For frequency domain measurements, it is possible to configure the measurements in terms of orders (nX) 
when using fixed-frequency data acquisition, and to configure the measurements in terms of frequency (Hz) 
when using order-tracking data acquisition. 

• The average reference speed is now included/provided with all frequency-domain or time-domain 
measurements (waveforms) sent to VibroSight. 
Note: Previously, the instantaneous speed was included/provided which could result in plot errors when using 
doubly-integrated measurement data. 

• Added support for a third dual-processing channel (in order to help support quad-channel processing such as 
journal bearing vibration (“sleeve bearing vibration”) in VibroSight). 

Bug fixes: 

• Dual-channel data for dynamic channels was returned when data for auxiliary channels was requested 
(depending on the configuration). 

• Shaft absolute vibration processing, which uses shaft relative vibration processing and bearing absolute 
vibration processing, only accepted velocity sensors or velocimeters (requiring single integration) – but will now 
also work with accelerometers (requiring double integration). 

• Shaft absolute vibration processing failing due to lack of synchronisation between the constituent shaft relative 
vibration processing and bearing absolute vibration processing, related to the different levels of integration 
(1 or 2) of the sensor / measurement channel vibration signal that can be required. 

Restrictions: 

• Compatible with the latest SIL machinery protection firmware (640-024-002T005) and VibroSight 7.8 only. 
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SIL recovery firmware: 640-026-003-000 

New features: 

• None. 

Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

• Handling, storage and use of IP address, subnet mask and default gateway addresses. 

• Module stopped operating normally (crashed) when the NTP server time changed significantly, that is, with 
large jumps in time. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

Protection test firmware: 640-032-005-000 

NOTE: Please note that the protection test firmware (640-032-vvv-ppp) is the only 
firmware common/shared by the STD and SIL versions of the VM600Mk2 MPC4Mk2 + 
IOC4Mk2 modules. 

 

New features: 

• None. 

Bug fixes: 

• Added support for dates and times in the year 2038 and beyond (timestamp data type / operating system issue, 
known as the year 2038 problem and/or Y2K38). 

Restrictions: 

• Compatible with the latest (STD) recovery firmware (640-031-008-000), the latest SIL recovery firmware (640-
026-003-000) and VibroSight 7.8 only. 

 

See also 6.2 VM600Mk2/VM600 modules (cards). 
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2.15 AMC10Mk2 + IOC10Mk2 module hardware 

The VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module is available in one (standard) 
version, as follows. 

• VM600Mk2 AMC10Mk2 + IOC10Mk2. 
Note: PNR 600-059 for the AMC10Mk2 and 600-061 for the IOC10Mk2. 

 

 

2.16 AMC10Mk2 + IOC10Mk2 module firmware 

New VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module firmware to support the initial 
launch of this new module: 

 

Machinery protection firmware: 640-040-001-000 

New features: 

• Initial release to support new module. 

Bug fixes: 

• None. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

Condition monitoring firmware: 640-042-001-000 

New features: 

• Initial release to support new module. 

Bug fixes: 

• None. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 
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Recovery firmware: 640-038-001-000 

New features: 

• Initial release to support new module. 

Bug fixes: 

• None. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

Protection test firmware: 640-041-001-000 

New features: 

• Initial release to support new module. 

Bug fixes: 

• None. 

Restrictions: 

• Compatible with VibroSight 7.8 only. 

 

See also 6.2 VM600Mk2/VM600 modules (cards). 

 

 

2.17 CPUMMk2 + IOCNMk2 module firmware 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module firmware with the 
following main improvements: 

 

Base-system / Applications firmware: base-system-640-034-006-000 

New features: 

• Support for new VM600Mk2 AMC10Mk2 + IOC10Mk2 temperature and analog monitoring module added. 

• Support for GOOSE (IEC 61850) fieldbus communications interface/protocol added. 

Bug fixes: 

• Some exceptions not being properly handled, resulting in corrupted messages being printed / logged. 

Restrictions: 

• Compatible with VibroSight 7.8 or later. 

See also 6.2 VM600Mk2/VM600 modules (cards). 
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VibroSmart modules 

2.18 VSI010 + VSB010 module firmware 

Updated VibroSmart VSI010 + VSB010 communications interface module firmware with the following main 
improvements: 

 

642-002-000-017 

Bug fixes: 

• GOOSE (IEC 61850) register addresses incorrectly parsed as hexadecimal when they were decimal (integers). 

• PROFINET MAC address sent to netX communications interface (chip) could be incorrect due to a bug in 
hexadecimal to decimal conversion (library function). 

New features: 

• None. 

Restrictions: 

• Compatible with VibroSight 7.8 or later. 

 

See also 6.3 VibroSmart devices. 
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3 Functional safety 

This section of the release notes highlights important information required to use a VM600Mk2 machinery monitoring 
system as a machinery protection system (MPS) in a safety-related application (functional safety context), in 
accordance with the IEC 61508 “functional safety” standard.  

That is, this section is related to the SIL safety versions of the modules, suitable for critical applications demanding 
the highest level of protection: 

• VM600Mk2 MPC4 Mk2 + IOC4 Mk2 SIL machinery protection and condition monitoring module. 
Note: PNRs 600-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL. 

• VM600 Mk2 RLC16 Mk2 SIL relay module. 
Note: PNR 600-044 for the RLC16Mk2 SIL. 

 

3.1 VibroSight 7.8.x and functional safety 

The VibroSight 7.8.0 software incorporates new firmware(s) for the VM600Mk2 MPC4 Mk2 + IOC4 Mk2 SIL machinery 
protection and condition monitoring module. 

Accordingly, please refer to the following sections in the software release notes: 

• 2.12 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) 

• 2.14 MPC4Mk2 + IOC4Mk2 SIL module firmware (SIL) 

• 6.2 VM600Mk2/VM600 modules (cards) 

• 7.2.1 VM600Mk2/VM600 module/card firmware. 
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4 Solved problems and bug fixes 

4.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.8.0 software. 

 

4.2 Problems working with large system racks with a lot of modules 

Under certain circumstances, when working with large system racks (VM600Mk2/VM600 ABE04x – 6U) with more 
complicated configurations (lots of modules), it was sometimes not possible to open the configuration and/or 
activate the configuration. 

 

4.3 VibroSight Vision problem connecting to a server and displaying table plots 

For a VibroSight Vision project using a Table plot to display live data from a VibroSight Capture server, after 
restarting VibroSight Vision and reopening the project, Vision could not automatically reconnect to the server and 
could not automatically display/update the data in the plot (even though the VibroSight Vision project was saved). 

A similar problem was also seen with VibroSight Mimic (also used to display live data). 

 

4.4 VibroSight Capture problem configuring offsets for a VM600Mk2 XMx16 module 

In VibroSight Capture, when trying to configure an offset for the sensor / measurement chain of a measurement 
channel of a VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring module, it was not possible to 
enter a decimal value. For example, it was possible to enter 12 but not 12.34. 

 

4.5 VibroSight applications problem when connecting to devices 

In VibroSight applications such as VibroSight Event Viewer, VibroSight Mimic or VibroSight Vision, when trying to 
connect to a device (data source type), the applications log file logged (recorded) multiple error messages related 
to a controller that cannot be found for event entities. 

For example: 
“ERROR … Client.DataInterfaces.Devices.DeviceSubDataInterface … No provider found for 
the entity User Event# …” 

 

4.6 VibroSight Server problem parsing an event 

For a VibroSight Server running a system with VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition 
monitoring modules, there was a problem characterised by an MPC4Mk2 module reporting an error while parsing an 
event (id: 0x00030005) and the Server dashboard displaying full capacity “server memory usage” even though less 
than half of the computer’s available RAM memory was being used (≈20 GB out of 64 GB). 
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4.7 VibroSight Scope problem displaying vibration signals for a VibroSmart VSV30x module 

In VibroSight Scope, when trying to display the measurements from a VibroSmart VSV30x + VSB300 monitoring 
module configured with two Narrow band vibration processing blocks, VibroSight Scope would only display a 
measurement for one of the processing blocks. 

In fact, this “problem” was traced back to the fact that the VibroSmart VSV30x module’s two Narrow band vibration 
processing blocks were both configured to use the same reference speed (tacho processing block), which is not 
allowed. 

NOTE: Narrow-band vibration (NB) is an order-tracked measurement and requires a 
tachometer input (1/rev) in order to track rotational speed. 
For a VibroSmart VSV30x + VSB300 monitoring module, each Narrow band 
vibration processing block requires its own dedicated tacho processing block. 

 

Accordingly, the VibroSight Configurator’s Consistency Check has been updated to include just such a consistency 
check and an appropriate message in order to inform the user that “using the same speed for 2 different narrow 
band processing blocks is not allowed”. 

 

4.8 Labelling of magnetic-flux measurements from the Hydro air-gap monitoring package 

In VibroSight, the magnetic-flux measurements from the Hydro air-gap monitoring package used the same labelling 
as the air-gap measurements, making it difficult to distinguish between the two different types of measurement (flux 
versus gap) when analysing data. That is, the magnetic-flux measurements per pole were named “Gap P1” to 
“Gap Pn” (exactly the same as the air-gap measurements per pole). 

Accordingly, VibroSight Protect has been updated to now use the names “Flux P1” to “Flux Pn” for magnetic-flux 
measurements. 

 

4.9 VibroSight Protect Dashboard not suggesting a system activation after a configuration 
change 

In VibroSight Protect, after using the Configure tab/page to make certain changes related to the configuration of a 
VM600Mk2 MPC4Mk2 module’s relays and/or analog outputs, and then going directly to the Dashboard tab/page, the 
Dashboard did not detect that there were configuration changes and suggest that the system should be 
reactivated. 

More specifically, the Dashboard did not automatically detect that the active configuration on the modules (devices) 
no longer matched the configuration in VibroSight Protect (file) and suggest a system activation, as required. 
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4.10 VibroSight Protect problem when changing the physical quantity of a sensor / 
measurement chain to volumetric flow rate 

In VibroSight Protect, when editing/updating the configuration of a VM600Mk2 MPC4Mk2 module’s measurement 
channel (that is, the input sensor / measurement chain configuration) for a channel that had already been 
configured with alarms enabled, and then changing the measurement’s physical quantity to volumetric flow rate 
(default unit: m3/s), VibroSight Protect could stop working normally (that is, crash with an exception error). 

 

4.11 VibroSight Protect problem when configuring a GOOSE (IEC 61850) fieldbus 
communications interface for a VibroSmart VSI010 module 

In VibroSight Protect, after configuring a communications interface of a VibroSmart VSI010 + VSB010 
communications interface module to use the GOOSE (IEC 61850) fieldbus communications interface/protocol to 
export/share data from a VibroSmart VSB30x + VSB300 monitoring module, the Machinery view of Published 
measurements was not correct. 

More specifically, in the list of Published measurements displayed, the first measurement assigned is incorrectly 
repeated for all measurements (rather than listing the different measurements that were assigned/configured).  
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5 Known issues 

5.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH), who have recently implemented a fix. However the improved UPC UA library is not 
included in the latest release of VibroSight. 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

5.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

5.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

5.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 
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However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

5.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

5.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 
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5.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

5.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

5.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

5.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

5.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 

5.12  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 
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During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully run. 

NOTE: The VibroSight software’s TCP and UDP port requirements are described in detail 

in the “Software installation” section of the latest  Getting started with 
VibroSight installation guide. See section 4. After installing VibroSight. 

 

5.13  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 
 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 
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6 Compatibility 

The VibroSight 7.x.x software has certain prerequisite software that must be available on the computer before 
VibroSight can be installed and/or run. 

Accordingly, as part of the VibroSight software installation process, the VibroSight installer will automatically check 
to see if the required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core 
Components Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft .NET Framework must either be manually installed by the user or can be automatically 
installed by the VibroSight installer if it is not detected, depending on the particular version of VibroSight 
(see section 6.1.2). 

• The required Microsoft Visual C++ Redistributable Package is automatically installed by the VibroSight installer 
if it is not detected (see section 6.1.3). 

• The required OPC Core Components Redistributable software is automatically installed by the VibroSight 
installer if it is not detected (see section 6.1.4). 

• The required OPC UA Local Discovery Server software is automatically installed by the VibroSight installer if it 
is not detected (see section 6.1.5). 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

6.1 VibroSight software 

VibroSight 7.8.0 is a minor level release and replaces VibroSight 7.7.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved by automatically applying an 
internal data migration process from existing VibroSight databases (VibroSight historical data folders (*.vshdf) 
and/or VibroSight historical data archives (*.vshda)), if and when required. 

NOTE: Since VibroSight 7.4.0, it is no longer possible to migrate older machinery 
monitoring projects using Sybase SQL Anywhere databases to VibroSight historical 
data repositories. 

In order to migrate such older projects using Sybase SQL Anywhere databases to 
VibroSight historical data repositories, VibroSight 7.3.x or earlier 
(also VibroSight 3.x.x or later) must be used. 

 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 
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Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• For existing machinery monitoring projects using VibroSight historical data repositories, the VibroSight 
historical data repositories are automatically updated if and when required (for example, to support new 
features). 

• For existing machinery monitoring projects using Sybase SQL Anywhere databases (that is, created with 
versions of VibroSight earlier than VibroSight 3.0.0), the project must be manually migrated from Sybase SQL 
Anywhere databases to VibroSight historical data repositories. 

Note: This data migration must be done using VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) – before 
they can be used with VibroSight 7.x.x (also VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the  Getting started with VibroSight installation 
guide  
(Note: For example, using the VibroSight 7.3.x software – see the earlier version of 
the installation guide: version 33.) 

The manual migration of a VibroSight OPC server is described in detail in the 
“VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide  
(Note: For example, using the VibroSight 7.4.x software – see the earlier version of 
the installation guide: version 34.) 

 
6.1.1 Microsoft Windows operating systems 
Since VibroSight 7.4.0, the VibroSight software is available as a single version: VibroSight (“VibroSight_64_bit”), 
which is 64-bit software (“x64 native”) optimised to run on 64-bit versions of Microsoft ® Windows ® operating 
systems. (Previously, the VibroSight software was available as 64-bit or 32-bit software.) 

NOTE: The 64-bit version of VibroSight can be installed on 64-bit Microsoft ® Windows ® 
computers only. 

Only a single version of VibroSight can be installed and exist on a computer at any 
one time. 

 
See also the Appendix of these release notes for further information on VibroSight software and Windows 
operating system compatibility. 
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6.1.2 Microsoft .NET Framework 
The required version of Microsoft .NET depends on the particular version of VibroSight. 

For VibroSight 7.8.x, the required versions of Microsoft .NET are: 

• .NET 8.0 Desktop Runtime (v8.0.20) - Windows x64 installer or later 
(“windowsdesktop-runtime-8.0.20-win-x64.exe”) 

and 

• ASP.NET Core 8.0 Runtime (v8.0.20) - Windows x64 installer or later 
(“aspnetcore-runtime-8.0.20-win-x64.exe”). 

NOTE: For information on the Microsoft .NET requirements for other versions of 
VibroSight, see the appendix of this installation guide and the latest  

 Getting started with VibroSight installation guide. 

 

If the required Microsoft .NET is not already installed on the computer that will run VibroSight, then it must be 
installed manually by the user using one of Microsoft’s .NET installers. For example, available from microsoft.com 
(https://dotnet.microsoft.com/en-us/download/dotnet/8.0). 

Refer to the latest  Getting started with VibroSight installation guide for further information. 

 

6.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and automatically install it as part of the VibroSight software installation process. 

Refer to the latest  Getting started with VibroSight installation guide for further information. 

 

6.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation process. 

Refer to the latest  Getting started with VibroSight installation guide for further information. 

 



 
 
 

 
 
 
 

VibroSight 7.8.0 software release notes 
Document reference VIBROSIGHT-RN/E (660-010-013-241A) 
 

Version 41 – 22.09.2025 
71 / 110 

 

6.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 

 

6.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Since VibroSight 7.4.0, it is no longer possible to migrate older machinery monitoring projects using Sybase SQL 
Anywhere databases to VibroSight historical data repositories. 

For further information on VibroSight and Sybase SQL Anywhere, including the manual migration of older projects 
using Sybase SQL Anywhere to VibroSight, refer to VibroSight 7.3.x or earlier release notes and/or installation 
guide. 

See also 6.1 VibroSight software. 

 

6.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 

 

6.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 
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MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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6.2 VM600Mk2/VM600 modules (cards)  

6.2.1 Module (card) firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules (cards) corresponding to VibroSight 7.8.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Machinery protection: 640-025-012-000.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-008-000.VxeFw (updated) 

• Recovery: 640-031-008-001.Mpc4g2Fw (updated) 

• Protection test: 640-032-005-000.VxeFw (updated). 

See 2.12 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) and 2.13 MPC4Mk2 + IOC4Mk2 module 
firmware (standard). 

 

The latest firmware for the VM600Mk2 MPC4Mk2 SIL module is now: 

• Machinery protection: 640-024-002T005.SafeMpc4g2Fw (updated) 

• Condition monitoring: 640-033-007-001.VxeFw (updated) 

• Recovery: 640-026-003-000.SafeMpc4g2Fw (updated) 

• Protection test: 640-032-005-000.VxeFw (updated). 

See 2.12 MPC4Mk2 + IOC4Mk2 module hardware (standard and SIL versions) and 2.14 MPC4Mk2 + IOC4Mk2 SIL 
module firmware (SIL). 

 

The latest firmware (initial release) for the VM600Mk2 AMC10Mk2 module is: 

• Machinery protection: 640-040-001-000.Amc10Fw 

• Condition monitoring: 640-042-001-000.VxeFw 

• Recovery: 640-038-001-000.Amc10Fw 

• Protection test: 640-041-001-000.VxeFw. 

See 2.15 AMC10Mk2 + IOC10Mk2 module hardware and 2.16 AMC10Mk2 + IOC10Mk2 module firmware. 
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The latest firmware for the VM600Mk2 CPUMMk2 module is now: 

• Base-system: base-system-640-034-006-000.tgz (updated). 

See 2.17 CPUMMk2 + IOCNMk2 module firmware. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Applications: applications-640-015-001-007.tgz 

• Base-system : base-system-640-014-001-007.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base-system: base-system-640-011-001-005.tgz. 

 

The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Applications: applications-640-010-001-018.tgz 

• Base-system: base-system-640-003-001-018.tgz. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

6.3 VibroSmart devices 

6.3.1 Module firmware 

There are some firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.8.0. 

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-022.xtranfw. 

 

The latest firmware for the VSI010 module is now: 

• 642-002-000-017.xmsifw (updated). 

See 2.18 VSI010 + VSB010 module firmware. 
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The latest firmware for the VSN010 device remains: 

• 642-004-000-013.redboxfw. 

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are recommended. 
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7 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: Before starting a VibroSight system update, it is strongly recommended to verify 
the version of firmware(s) running on the related hardware (VM600Mk2/VM600 
and/or VibroSmart modules/devices) in order to establish if any firmware 
changes/upgrades are also required. 
See 7.2.3 Updating the firmware using VibroSight System Manager. 

 

IMPORTANT 
NOTE: 

Before upgrading the firmware of any of the hardware (VM600Mk2/VM600 and/or 
VibroSmart modules/devices) used in a VibroSight system, it is strongly 
recommended to ensure that a copy of the configuration for the system is available 
– in case it is necessary to reconfigure the system after the upgrade. 
See 7.2.3 Updating the firmware using VibroSight System Manager. 

 

 

7.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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7.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 and/or VibroSmart 
modules/devices to be upgraded to the latest firmware, in order to take advantage of improvements to the 
VibroSight software. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the card or module being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

IMPORTANT 
NOTE: 

It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For example, for VibroSmart modules, the machinery being monitored is not protected for the duration of a 
firmware update and the restart (reboot) that is triggered automatically after the firmware update (which can take up 
to 5 minutes). 
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7.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. 

For example, the MPC4 Mk2 subfolder contains the firmware components for use by the MPC4Mk2 module 
(standard versions) and the MPC4 Mk2 SIL subfolder contains the firmware components for use by the 
MPC4Mk2 SIL module (SIL versions). Any additional firmware updates received from parker Meggitt (Meggitt SA) 
should also be stored in these directories. 

 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for the original version of the MPC4Mk2 (PNR 600-041-000-001) – no longer supported. 
See 2.12 MPC4Mk2 + IOC4Mk2 module hardware. 

Table 3 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 SIL module hardware (that 
is, MPC4Mk2 SIL firmware). 

IMPORTANT 
NOTE: 

When changing (upgrading) all firmware components on a VM600Mk2 MPC4Mk2 
module, the module must be in the Recovery mode in order to change the 
protection test firmware. 

It is important to note that entering the Recovery mode clears the modules 
configuration, which means that the module (system) must be reconfigured after 
leaving the Recovery mode – before normal system operation can be resumed. 

Accordingly, it is strongly recommended to ensure that a copy of the configuration 
for the system is available before upgrading a system. For example, the VibroSight 
software can be used to connect to a system (which will automatically 
read/download the system configuration) and save a copy of the configuration. 

 

Table 4 shows the compatibility between VibroSight software and VM600Mk2 AMC10Mk2 module hardware (that is, 
AMC10Mk2 firmware). 
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Table 5 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 6 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 7 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 

 

Table 8 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 
for later standard versions of the MPC4Mk2 (PNRs 600-041 / 600-041-001-002 and 600-041-000-002) 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight 
software version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

640-025- 

007-001 

640-025- 

008-000 

640-025- 

009-001 

640-025- 

010-000 

640-025- 

011-000 

640-025- 

012-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- 640-033- 

001-000 

640-033- 

002-000 

640-033- 

003-000 

640-033- 

004-000 

640-033- 

005-000 

640-033- 

006-000 

640-033- 

007-000 

640-033- 

008-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-006 

640-031- 

005-001 

640-031- 

006-000 

640-031- 

007-000 

640-031- 

007-001 

640-031- 

008-001 

Protection test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-001 

640-032- 

003-000 

640-032- 

004-000 

640-032- 

004-001 

640-032- 

005-000 

7.0.0 
609-010-000-001 

 See 

note 1a 
 See 

note 1b 

       

7.1.0 
609-010-000-001 

   See 

note 2 

      

7.2.0 
609-010-000-001 

    See 

note 3 

     

7.3.0 
609-010-000-001 

     See 

note 4 

    

7.4.0 
609-010-000-001 

      See 

note 5 
   

7.5.0 
609-010-000-001 

         

7.6.0 
609-010-000-001 

       See 

note 6 
  

7.7.0 
609-010-000-001 

        See 

note 7 
 

7.8.0 
609-010-000-001 

         See 

note 8 
 
Notes for Table 1 (see the next page)   
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Notes for Table 1 
 
1a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
1b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.4 release notes. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
 
6. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
 
7. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.7 release notes. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
 
8. For information on these versions of VM600Mk2 MPC4Mk2 firmware, see 2.13 MPC4Mk2 + IOC4Mk2 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.8.0 or later. 
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Table 2: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 
for the original standard version of MPC4Mk2 (PNRs 600-041 / 600-041-000-001) – no longer supported 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Protection test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 2 (see the next page) 
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Notes for Table 2 
 

1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Parker Meggitt (Meggitt SA) for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0. 
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Table 3: VibroSight software and VM600Mk2 MPC4Mk2 SIL firmware compatibility 
for the SIL version of the MPC4Mk2 (PNRs 600-040 / 600-040-vvv-vvv) 

 VM600Mk2 MPC4Mk2 SIL firmware 

VibroSight 
software version 

Part number 
(PNR) 

SIL machinery protection firmware 
(640-024-vvv-ppp.SafeMpc4g2Fw) 

640-024-

001T005 

640-024-

001T006 

640-024-001-

000 

640-024-

002T002 

640-024-

002T004 

640-024-

002T005 

Condition monitoring firmware 
(640-033-vvv-ppp.VxeFw) 

640-033-004-

000 

640-033-005-000 640-033-006-

000 

640-033-007-

000 

640-033-007-

001 

SIL recovery firmware  
(640-026-vvv-ppp.SafeMpc4g2Fw) 

640-026-001-000 640-026-002-

000 

640-026-002-

001 

640-026-003-

000 

Protection test firmware 
(640-032-vvv-ppp.VxeFw) 

640-032-004-000 640-032-004-001 640-032-005-

000 

7.3.0 
609-010-000-001 

 See note 1  
    

7.4.0 
609-010-000-001 

  See note 2     

7.5.0 
609-010-000-001 

   See note 3    

7.6.0 
609-010-000-001 

    See note 4   

7.7.0 
609-010-000-001 

     See note 5  

7.8.0 
609-010-000-001 

      See note 6 
 

Notes for Table 3 (see the next page) 
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Notes for Table 3 
 
1. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.4 release notes. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.5 release notes. 
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.7 release notes. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
 
6. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, see 2.14 MPC4Mk2 + IOC4Mk2 SIL module firmware (SIL). 
A firmware upgrade is required in order to run VibroSight 7.8.0 or later. 
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Table 4: VibroSight software and VM600Mk2 AMC10Mk2 firmware compatibility 

 VM600Mk2 AMC10Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware 
(640-040-vvv-ppp.Amc10Fw) 

640-040- 

001-000 

Condition monitoring firmware 
(640-042-vvv-ppp.VxeFw) 

640-042- 

001-000 

Recovery firmware 
(640-038-vvv-ppp.Amc10Fw) 

640-038- 

001-000 

Protection test firmware 
(640-041-vvv-ppp.VxeFw) 

640-041- 

001-000 

7.8.0 
609-010-000-001 

 See note 1 

 

Notes for Table 4 
 
1. For information on these versions of VM600Mk2 AMC10Mk2 firmware, see 2.18 VSI010 + VSB010 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.8.0 or later. 
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Table 5: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034- 

001-001 

640-034- 

002-000 

640-034- 

003-000 

640-034- 

003-001 

640-034- 

004-000 

640-034- 

005-001 

640-034- 

006-000 

7.0.0 
609-010-000-001 

 See note 1  
     

7.1.0 
609-010-000-001 

  See note 2  
    

7.2.0 
609-010-000-001 

   See note 3 
    

7.3.0 
609-010-000-001 

    See note 4    

7.4.0 
609-010-000-001 

       

7.5.0 
609-010-000-001 

     See note 5   

7.6.0 
609-010-000-001 

       

7.7.0 
609-010-000-001 

      See note 6  

7.8.0 
609-010-000-001 

       See note 7 
 

Notes for Table 5 (see the next page) 
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Notes for Table 5 
 

1. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

2. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is not required but is strongly recommended in order to run VibroSight 7.3.0 or later. 
 
5. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.5 release notes. 
It is important to note that this firmware version is incompatible with previous VM600Mk2 CPUMMk2 firmware versions or the VM600 CPUR2 card 
and may cause hardware damage if installed. Therefore, to ensure compatibility and prevent any issues, a VM600Mk2/VM600 rack should only 
contain CPUMMk2 modules with firmware version 640-034-004-000 or later. Also, during the firmware upgrade process, it's crucial to remove all 
other VM600Mk2 CPUMMk2 modules or VM600 CPUR2 cards from the rack in order to avoid potential damage. That is, ensure that only the 
VM600Mk2 CPUMMk2 module receiving the firmware upgrade is present in the rack during the upgrade process. 
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 
 
6. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.7 release notes. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
 
7. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.17 CPUMMk2 + IOCNMk2 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.8.0 or later. 
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Table 6: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014-001-

005 

640-014-001-

006 

640-014-001-

007 

Applications firmware (*.tgz) 

640-015- 

001-005 

640-015- 

001-006 

640-015- 

001-007 

7.0.0 
609-010-000-001 

 See note 2 
  

7.1.0 
609-010-000-001 

  See note 3  

7.2.0 
609-010-000-001 

   

7.3.0 
609-010-000-001 

   

7.4.0 
609-010-000-001 

   

7.5.0 
609-010-000-001 

   

7.6.0 
609-010-000-001 

   See note 4 

7.7.0 
609-010-000-001 

   

7.8.0 
609-010-000-001 

   
 
Notes for Table 6 (see the next page) 
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Notes for Table 6 
 

1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base-system and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base-system and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
4. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.6 release notes. 
 
 
 
  



 
 
 

 
 
 
 

VibroSight 7.8.0 software release notes 
Document reference VIBROSIGHT-RN/E (660-010-013-241A) 
 

Version 41 – 22.09.2025 
91 / 110 

 

Table 7: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

7.0.0 
609-010-000-001 

 See note 2  See note 3 

7.1.0 
609-010-000-001 

  

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

7.4.0 
609-010-000-001 

  

7.5.0 
609-010-000-001 

  

7.6.0 
609-010-000-001 

  

7.7.0 
609-010-000-001 

  

7.8.0 
609-010-000-001 

  
 

Notes for Table 7 (see the next page) 
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Notes for Table 7 
 

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base-system and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base-system and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-vvv)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 8: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 640-003-001-017 640-003-001-018 

Applications firmware (*.tgz) 

640-010-001-016 640-010-001-017 640-010-001-018 

7.0.0 
609-010-000-001 

 See note 2   

7.1.0 
609-010-000-001 

   

7.2.0 
609-010-000-001 

   

7.3.0 
609-010-000-001 

   

7.4.0 
609-010-000-001 

   

7.5.0 
609-010-000-001 

  See note 3  See note 4 

7.6.0 
609-010-000-001 

   

7.7.0 
609-010-000-001 

   

7.8.0 
609-010-000-001 

   
 

Notes for Table 8 (see the next page) 
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Notes for Table 8 
 

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base-system and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in 
the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base-system, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
 

3. For information on this version of VM600 XMx16 firmware, refer to the VibroSight 7.5 release notes.  
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 
 

4. For information on this version of VM600 XMx16 firmware, refer to the VibroSight 7.7 release notes  
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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7.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Parker Meggitt (Meggitt SA) should also be stored in these directories. 

Table 9 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 10 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 11 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 9: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight software 
version 

Part number (PNR) 

642-002- 

000-013 

642-002- 

000-014 

642-002- 

000-015 

642-002- 

000-016 

642-002- 

000-017 

7.0.0 
609-010-000-001 

See notes 

2 and 3 

    

7.1.0 
609-010-000-001 

 
See notes 

2 and 4 
   

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

7.5.0 
609-010-000-001 

     

7.6.0 
609-010-000-001 

  
See notes 

2 and 5 
See notes 

2 and 6 
 

7.7.0 
609-010-000-001 

     

7.8.0 
609-010-000-001 

    See notes 

2 and 7 
 

Notes for Table 9 (see the next page) 
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Notes for Table 9 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

4. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

5. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.7 release notes. 
A firmware upgrade is required in order to run VibroSight 7.7.0 or later. 
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7. For information on this version of VibroSmart VSI010 firmware, see 2.18 VSI010 + VSB010 module firmware. 
A firmware upgrade is required in order to run VibroSight 7.8.0 or later. 
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Table 10: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 642-004-000-013 

7.0.0 
609-010-000-001 

 See note 2 
  

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 
 

7.2.0 
609-010-000-001 

   

7.3.0 
609-010-000-001 

   

7.4.0 
609-010-000-001 

   

7.5.0 
609-010-000-001 

   

7.6.0 
609-010-000-001 

  
See notes 

2 and 4 
7.7.0 

609-010-000-001 
   

7.8.0 
609-010-000-001 

   
 

Notes for Table 10 (see the next page) 
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Notes for Table 10 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

4. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
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Table 11: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-019 642-001-000-020 642-001-000-021 642-001-000-022 

7.0.0 
609-010-000-001 

See notes 

2 and 3 

   

7.1.0 
609-010-000-001 

 
See notes 

2 and 4 
  

7.2.0 
609-010-000-001 

    

7.3.0 
609-010-000-001 

    

7.4.0 
609-010-000-001 

    

7.5.0 
609-010-000-001 

  
See notes 

2 and 5 
 

7.6.0 
609-010-000-001 

   See notes 

2 and 6 
7.7.0 

609-010-000-001 
    

7.8.0 
609-010-000-001 

    
 

Notes for Table 11 (see the next page) 
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Notes for Table 11 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

4. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

5. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.5 release notes.  
A firmware upgrade is required in order to run VibroSight 7.5.0 or later. 
 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.6 release notes. 
A firmware upgrade is required in order to run VibroSight 7.6.0 or later. 
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7.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600Mk2/VM600 and/or VibroSmart modules/devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 and/or VibroSmart modules/devices 
firmware update may lead to incoherent system behaviour and affect the proper functioning of data acquisition in a 
system. It is only in systems where the firmware running on the VM600Mk2/VM600 and/or VibroSmart 
modules/devices already corresponds to the latest available version that no firmware update is required. Therefore, 
it is strongly recommended to verify the version of firmware running on the hardware before starting a VibroSight 
system upgrade, in order to establish if a firmware update is also required. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the module or card being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 



 
 
 

 
 
 
 

VibroSight 7.8.0 software release notes 
Document reference VIBROSIGHT-RN/E (660-010-013-241A) 
 

Version 41 – 22.09.2025 
104 / 110 

 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware 
(VM600Mk2/VM600 and/or VibroSmart modules/devices) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no VM600Mk2/VM600 and/or VibroSmart modules/devices in the tree structure or some are missing, 
verify your network connections. 

3. Select the module or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VM600Mk2/VM600 or VibroSmart modules/devices selected. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
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independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

 

7.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 
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Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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8 Customer support 

8.1 Contacting us 

Parker Meggitt worldwide customer support network offers a range of support including Technical support and 
Sales and repairs support. For customer support, please contact your local Parker Meggitt representative. 
Alternatively, contact our main office: 

Customer support  
Parker Meggitt (Meggitt SA) 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

8.2 Technical support 

Parker Meggitt technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

8.3 Sales and repairs support 

Parker Meggitt sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

and extended support ended in 2023 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

and extended support ended in 2023 
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VibroSight software and Microsoft® .NET requirements 

VibroSight software version Microsoft .NET requirements 

VibroSight 7.8.x or later 
.NET 8.0 Desktop Runtime (v8.0.20) or later 

and 
ASP.NET Core 8.0 Runtime (v8.0.20) or later See note 1 

VibroSight 7.6.x or later .NET 8.0 Desktop Runtime (v8.0.8) or later 

VibroSight 7.4.x or later .NET 7.0 SDK v7.0.306 or later 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 2 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 3 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 4 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 

Notes 

1. The ASP.NET Core Runtime is dependent on the .NET Runtime. 

2. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

3. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

4. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 
installing Microsoft .NET Framework 2.0). 
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